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Get Help

There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications

Use help icons @ to access help in the application. If you don't see any help icons on your page, click your user image
or name in the global header and select Show Help Icons.

Get Support

You can get support at My Oracle Support. For accessible support, visit Oracle Accessibility Learning and Support.

Get Training

Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community

Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You
can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch
events.

Learn About Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program. Videos included in
this guide are provided as a media alternative for text-based topics also available in this guide.

Share Your Feedback

We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!

ORACLE


https://support.oracle.com/portal/
https://www.oracle.com/corporate/accessibility/learning-support.html#support-tab
https://www.oracle.com/education/
https://cloudcustomerconnect.oracle.com/pages/home
https://community.oracle.com/customerconnect/categories/idealab-guidelines
https://www.oracle.com/corporate/accessibility/
mailto:oracle_fusion_applications_help_ww_grp@oracle.com

Oracle Fusion Cloud Procurement Get Help
Creating and Administering Analytics and Reports for
Procurement

ii

ORACLE



Oracle Fusion Cloud Procurement Chapter 1
Creating and Administering Analytics and Reports for Overview
Procurement

1 Overview

About This Guide

If you administer or work with business intelligence (BI) in Oracle Applications Cloud, this guide is for you. It provides an
overview of Oracle Transactional Business Intelligence and covers common Bl features in your application.

For example, you can create analyses in the Reports and Analytics work area, personalize the infolets on your home
page, or configure flexfields for use in analytics.

Overview of Transactional Business Intelligence

You use Oracle Transactional Business Intelligence (OTBI) to analyze your business and take action with embedded and
ad-hoc analysis of your transactional data.

Key metrics and attributes of your business and organization are organized into subject areas of data you use as
building blocks to answer your business questions.

Use embedded analyses and reports to gain insights and report on key business metrics
Build ad-hoc analyses, reports, and dashboards.
- Create catalog folders and define who has access to what in the catalog.

- Organize your analytics in dashboards and embed them in your work areas.

Architecture

OTBI integrates with Application Development Framework (ADF) to run your real-time analysis of your business subject
areas.

The BI Server creates physical queries based on metadata mappings between the subject areas you work with in your
analysis and ADF view objects and their underlying database tables. The Presentation Server compiles and formats the
results in the client or as embedded analytics.
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Cracle Applications Cloud

] Database
Here's the OTBI architecture.

Bl Objects and Tools

Here are some of the components and the objects they support.

Catalog Object Description

Analysis Analyses are a selection of data displayed in
one or more views, such as a table or chart, to
provide answers to business questions.

Dashboard Dashboards organize analytical content
and catalog objects, and present themin a
meaningful way.

Dashboard Prompt Dashboard prompts allow users to filter
dashboard content by selecting from provided
values.

Filter Filters limit the results that are displayed when

an analysis is run.

Agent Agents deliver scheduled analytics and other
content and notifications.

Report Reports present data in pixel-perfect printable
format for distribution.
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Catalog Object Description Component or Tool

Data Model Data models define the data source for reports. = Analytics Publisher

Subtemplate Subtemplates are reusable formatting RTF or XSL editor

definitions for reports.

Note: You can't change privileges for the components, for example by changing which roles are assigned to access
Dashboards or Analytics Publisher. Any changes made to privileges in the Administration Manage Privileges page
aren't preserved during any upgrade.

The catalog stores the objects in a folder structure of individual files, organized hierarchically by product family.

- Shared folders (parent)

« Product family, for example, Financials
- Product, for example, Payables

- Report groups, for example, Invoices

- Dashboard reports

- Data models

- Report components

- Analytics Publisher reports

« Prompts

Some Oracle Transactional Business Intelligence components aren't available in Oracle Applications Cloud:

- Bl Server: Processes user requests and queries in underlying data sources.
- Catalog Manager: Manages catalog and objects.

- Administration Tool: Manages metadata repository that defines the logical structure and physical data sources
for analytic subject areas.

Related Topics
» More About Oracle Transactional Business Intelligence Components

More About Oracle Transactional Business Intelligence
Components

If you want to know more about Oracle Transactional Business Intelligence components, here's what we have.

ORACLE



Oracle Fusion Cloud Procurement Chapter 1
Creating and Administering Analytics and Reports for Overview
Procurement

Oracle Transactional Business Intelligence

Here's the information about the parts of Oracle Transactional Business Intelligence (OTBI) that support analysis against
your transactional data.

- Create and work with analyses, dashboards, and advanced analytical content, including dashboard prompts,
conditions, actions, and key performance indicators.
Creating Analyses and Dashboards in Oracle Transactional Business Intelligence

- Administer analyses, dashboards, and other content.

Administering Oracle Transactional Business Intelligence

Oracle Analytics Publisher

Analytics Publisher is the part of OTBI you use for reports.

Run and view reports.

Using Oracle Analytics Publisher in Oracle Transactional Business Intelligence
- Create and edit reports, data models, layouts, templates, subtemplates.

Designing Pixel-Perfect Reports in Oracle Transactional Business Intelligence

- Administer Analytics Publisher, set up data sources and delivery destinations, manage security, and move
catalog objects.

Administering Oracle Analytics Publisher in Oracle Transactional Business Intelligence

Overview of Creation and Administration of Procurement
Analytics and Reports

Business intelligence enables you to analyze data to gain insight that you can act on, gathering information to meet
specific requirements. You can use different types of predefined analytics and reports, or create and edit them, to
support your business needs.

Types of Business Intelligence

The following table describes and explains the purpose of analyses, dashboards and reports.

Type Description Purpose
Analysis An interactive display of data, for exampleina = To summarize or break down simple, real-time
table or graph. data, and help you make short-term decisions.
Dashboard A collection of analyses and other content, To get various pieces of information about a
presented on one or more pages, or tabs. particular subject.
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Type Description Purpose

Report Output of data in a readable, predefined format.. To get high-volume data in an output optimized

for printing, including documents to support
internal operations, statutory requirements, and
other business needs.

For alist of predefined analyses and reports, see Procurement Reports and Analyses

Modification of Analyses and Reports

You can create and edit analyses and reports for your own use. Or, if you have the appropriate roles, you can them
modify them for others. For example, you can:

- Add or remove columns from an analysis.
- Change the branding logo on report output.

- Create a dashboard to include your most commonly viewed analyses.

Setup and Administration

Administrators perform setup and administration tasks to manage how you or how other users use and modify analyses
and reports. For example, you can:

- Configure Oracle Analytics Publisher, the tool used for generating and editing reports.
- Define flexfields to provide user-defined attributes that can be used in analyses.
- Archive analyses and reports and move them from one environment to another.
For alist of setup reports, see Oracle Fusion Cloud Applications View Setup Reports and Analyses on the Oracle Help

Center. It provides details for all of the setup reports and analyses for cloud applications, each of which you can modify
to meet your company's requirements.

Security Overview of Procurement Analytics and Reports

All users with appropriate roles can create and access analyses and reports based on role access to subject areas and
catalog folders.

Analyses and reports are secured by applying job roles with associated duty roles to users. Duty role assignments
determine access to subject areas for analyses as well as catalog folders. For information about the job and duty roles
provided with Oracle Fusion Cloud Procurement, see the Oracle Fusion Cloud Procurement Security Reference for
Procurement guide. For information about modifying your security model, creating job roles and assigning duty roles to
them, see the Oracle Fusion Cloud ERP Securing ERP guide.

In addition to folder and object access, duty roles also determine data security. Each of the duty roles that provides
access to subject areas and catalog folders is granted one or more data security policies that allow access to the data.
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Related Topics

View Analytics, Reports, and Dashboards
® Watch video

There are different ways to view and work with your analytics and reports. You can view analyses, dashboards, and
reports in the course of your work, on your usual pages and infolets. Or you can find them in the business intelligence
catalog with the Reports and Analytics work area and the Reports and Analytics panel tab.

View Analytics in Infolets

Use your favorite infolet pages to find analytics.

1. Use the page controls and Previous and Next icons to explore infolet pages in the home page, where they may
appear in infolets with summaries and aggregations or performance metrics. You may also find infolets in some
work areas.

2. Click aninfolet to open a detailed analysis. So for example, if an infolet has transactions summed to a total, click
it to view details of the underlying transactions.

3. Click Done.

View Objects in Familiar Work Areas and Pages

Use analyses, dashboards, and reports available in your usual pages and work areas.

1. Explore your pages. Some may include analysis and report links or embedded objects, sometimes in tabs or
panel tabs.

2. Some work areas have a Reports and Analytics panel tab, where you explore catalog folders for relevant
analyses and reports for the work area. And if you have permission, you can map more objects to the work area
if they're appropriate.

a. Open the panel tab.

b. Expand the Shared Reports and Analytics folder and explore the available content.

c. Click the link for any object and see its type to determine whether it's an analysis, a report, or a
dashboard.

d. Click View to open the object.

View Objects in the Reports and Analytics Work Area

Use the Reports and Analytics work area to search or browse the catalog and view any analysis, dashboard, or report
you have access to. It opens at the highest level of the catalog's folder hierarchy with all objects you have marked as
favorites.

Here are some things you can do in the Reports and Analytics work area.

1. Click Navigator > Tools > Reports and Analytics.
2. Filter and search for objects:
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a. From the Filter list, select what you want to find.

b. To view objects you have marked as favorites, select Favorites in the list. Or select Recent Items to view
objects you recently worked with, or a recent search to run it again. Enter a name or part of a name and
click the Search icon.

c. Inthe search results, use the icons to identify what the objects are.

d. Click the name of an object to open it, or click More and select an action.

3. Inthe breadcrumbs, browse the catalog folders for analytics and reports. Click any Hierarchical Selector icon
to select a different node for the next level in the hierarchy.

4. Mark objects as favorites.

o Select Favorites in the Saved Searches to display your favorite objects.
o Click the Add Favorites icon for an object to mark it as a favorite.
o Click the Remove from Favorites icon to remove an object from your favorites.

5. Create and edit analyses and reports.

a. Click Create and select Report or Analysis.
b. Use wizards to create your analysis or report.
6. Click the Browse Catalog button (or click the More icon for a specific report, dashboard, or analysis) to use
more features.

Note: If you don't see an analysis in the work area, browse the catalog for it. In the Catalog, select Show
Hidden Items to display any hidden analyses.

View Analyses

An analysis queries against your company's data and answers business questions with visualizations, such as charts
and tables. They may appear on your pages, or as parts of a dashboard.

From the catalog folders or search results, open an analysis to view.

Click Refresh to rerun the analysis and refresh its data.

Click Print and select either Printable PDF or Printable HTML to open a printable version.

Click Export to get analysis data in various formats, for example PDF, Excel, PowerPoint, comma-separated
value (CSV), and XML.

PUWUNA

Note: When you export data in a CSV format, dates are exported in raw format and converted to UTC time
zone.

View Grouped Analyses in Dashboards

Some analyses are grouped in dashboards to give you meaningful related information. A dashboard contains pages of
analyses, prompts that filter information, and other objects.

1. From the catalog folders or search results, open a dashboard to view.
2. Select values for any dashboard prompts to filter the dashboard.
3. Click Apply to refine the results of all of the analyses in the dashboard.

ORACLE
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View Reports

Reports show data in a predefined format that's optimized for printing.

1. From the catalog folders or search results, open a report.
2. C(lick the View Report icon if you want a different format.

o Choose HTML or PDF to display the report in a format for printing. Because it's optimized for printing,
PDF often provides the best results.

o You can also export the report as RTF for editing in a word processor, or as Excel or PowerPoint.

3. From the catalog folders or search results, you can also do these tasks:

o Click Edit to edit the report properties, layout, and data model.
o Click Report History to see details about past submissions of the report.

o Click Schedule to schedule the report to be run.
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2 Setup and Management

Set Up Currency

Currency and Exchange Rate Settings for Analytics

CX Sales applications let you to decide how currency is shown in the application and set preferences for how analytics
show currency for different regions and calculate exchange rates.

Currency can be set in different regional currency types, depending on where you do business and what currency types
you want to see.

There are three ways you set up currency:

User Currency - Set by the business user in Regional settings. This setting applies to the entire application
interface for that user only. The available currency options are set by your application administrator.

- Analytics Currency - Set by the business user in Bl in My Account settings in the Reports area. The setting
applies to that user only and is only relevant for analyses.

- Corporate Currency - Set by the application administrator. This setting applies to all users in that company.

Note: The time zone preferences that you set in your fuse simplified user interface are inherited and used as the time
zone setting for your existing and new analytics.

Set General User Currency

User currency settings determine the currency used as the default for what you see in your application. User currency
applies to your entire interface for your signed-in session.

1. Navigate to Tools, Set Preferences.

2. Select General Preferences > Regional.

3. Select the preferred currency to be used. Available currencies include those set up for your company by your
application administrator.

Set Analytics Currency

The analytics currency settings determine the currency type that's displayed in all your analytics. It also determines how
and when your currency conversion rates are calculated.

1. Click Navigator Tools Reports and Analytics.

2. (Click Browse Catalog.

3. Click My Profile and select My Account.

4. Inthe Preference tab, select your choice in Currency.

This shows the currency display options for users:
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Currency Display Type Description

Entered Currency Currency used on a transaction.

<Application> Currency Currency set up in each respective Cloud application as the common Corporate currency used

company-wide.

User Preferred Currency using Simple Conversion to User Preferred Currency is performed at the time your run the report, and is calculated
Currency Management from the Corporate currency based on the last time the record was updated and saved or closed.

User Preferred Currency using Advanced Conversion to User Preferred Currency happens on the date your run the report, and uses the currency
Currency Management indicated on the record.

Set a Default Currency Conversion Option for All Users

By default your currency is converted to the corporate currency with a method we call "User Preferred Currency Using
Simple Currency Management".

The simple "User Preferred Currency Using Simple Currency Management" setting provides the best run-time
performance because when you run a report, the application doesn't have to look up the rate for each transaction. The
currency is converted to your corporate currency at that day's rate when you update and save a record. Otherwise, the
application cycles through each record at run-time and converts the currency one record at a time to the exchange rate
in effect at the time the report is run. For more information see, How User Preferred Currency Exchange Works.

But you can also standardize the setting for all system users, by setting the default preference to another option, such
as CRM Currency or User Preferred Currency Using Advanced Currency Management.

To change the default currency setting for all users, administrators need to add a profile option and a corresponding
value. Note that when administrators change the default currency setting for users in their organization, individual users
can still override that setting and select their preferred currency in My Account.

The following table shows the profile option code parameters to override the default currency setting.

Profile Code Profile Value Description

BI_DEFAULT_CURRENCY_CONVERSION_ CRM Currency - Defaults to Application Currency.
METHOD

BI_DEFAULT_CURRENCY_CONVERSION_ User Preferred Currency 1 - Defaults to User Preferred Currency Simple Currency Management.
METHOD

BI_DEFAULT_CURRENCY_CONVERSION_ User Preferred Currency 2 - Defaults to User Preferred Currency Advanced Currency Management.
METHOD

10
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Set a Global Currency Conversion Profile

Set a global currency conversion method for all your users by creating a currency profile. Only administrators can create
currency profiles.

1. In Setup and Maintenance, go to Manage Administrator Profile Values.
2. Enter the following values:
o Profile Option Code : BI_DEFAULT_CURRENCY_CONVERSION_METHOD
o Profile Display Name : Bl Default Currency Conversion Method
o Application
o Module
o Start Date : Provide previous day's date to proceed to next step to define values.

Click Save and Close.
In the Manage Profile Options dialog box, you see your new profile. Check the Enabled box for Site.
5. Click Save and Close.

P W

Related Topics
« Update Existing Setup Data

Define Currency Profile Values

After you create your currency profile, the last step is to define the profile value. This step defines which currency
management option is assigned to that profile.

In the Setup and Maintenance work area, use Manage Administrator Profile Values.

In Profile Option Code search for your profile: BI_DEFAULT_CURRENCY_CONVERSION_METHOD.
In Manage Administrator Profile Values, Click Add (+ icon).

Select Site as the Profile level.

Enter "User Preferred Currency 2" in Profile Value.

Click Save and Close.

cuhlhuNA

How User Preferred Currency Exchange Works

The simple and advanced user-preferred currency choices determine how and when your currency exchange rates are
calculated. For both simple and advanced currency management, when you save or close a report, the exchange rate is
set at that time.

The option you choose impacts how quickly your reports are generated at run time. Each case includes trade-offs, as
detailed in the examples.

n
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User Preferred Currency using Simple Currency Management

The advantage of this option is performance - the application doesn't have to look up the rate for each transaction
because when you close or save a record, the application converts it to your corporate currency at that day's rate. When
you run the opportunity report, the application multiplies that value by your preferred currency exchange rate for the
date you run the report. This eliminates the need for the application to cycle through each record, and calculate the
corresponding exchange rate to your preferred exchange rate at the time that record was closed or last saved. It simply
takes the value on record for the original transaction exchange to corporate currency, and multiplies it by your preferred
currency exchange rate at the time your run the report.

As an example of user preferred currency using simple currency management, a user updates and saves or closes an
opportunity record with associated revenue of one million Indian Rupees on January 31st with an exchange rate of
0.01401 Rupees to one US Dollar. The user then runs an opportunity report in US Dollars on March 31st. In the report,
the US Dollar Corporate Currency is set at the January 31st rate it was saved at, in this case reporting as $14,010, or one
million multiplied by 0.01401. Finally, an opportunity report on March 31st in Euros uses the March 31st conversion rate
for US Dollars to Euros of 0.75017 to convert the recorded US Dollar amount into Euros, in this example one million
multiplied by 0.01401, which is the January 31st Rupee to US Dollar exchange rate, multiplied by 0.75013, which is the
March 31st rate for Euros. This requires less processing, because the January 31st Rupee to US Dollar exchange rate,
while not exact on March 31st, is used as the basis for the calculation of the March 31st opportunity revenue conversion
to Euros at the later exchange rate.

The following figure describes an example of user preferred currency using simple currency management.

Example of User Preferred Currency using
Simple Currency Management:

User updates and
saves or closes record
on January 31%

User runs opportunity
report on March 31

Opportunity report on
March 31* shows all
opportunities in EUR

Opportunity Currency in
INR =10
Jan 31 exchange rate is
INR to USD = 0.01401

Corporate Currency in
USDis set at the Jan 3T
rate. 1M INE converted
to USD at rate when
closed or saved, in this
case 0.01401= $14010

User preferred currency
in EUR isshownin
report as March 317 rate
USD to EUR Q75017 =
EUR10,50% (10 x 0.1401
* 0.75017)

Exchange Rates

Jan 31% rate; USDto EUR = 0.75011
Jan 31% rate: INR to EUR = 001050
Jan 31% rate: INR to USD = 001401

Mar 317 rate: USD to EUR =0.75013
Mar 31%° mte: INR to ELUR = 0.01052

Mar 31%° mte: INR to USD = 0.01403

User Preferred Currency using Advanced Currency Management

This option provides a more precise exchange rate, since it goes through each record to determine the rate on the date
the record was updated or closed. The downside of this option is performance. Your reports will take longer to run. The
application has to cycle through each record and match currency exchange rates to the date the record was closed or
updated and saved.

As an example of user preferred currency using advanced currency management, a user updates and saves or closes

an opportunity record with associated revenue of one million Indian Rupees on January 31st, when an exchange rate

of 0.01050 Rupees to one Euro applies. The user then runs an opportunity report on March 31st. In the report, the User
Preferred Currency of Euros is applied, using the January 31st Rupee to Euro rate of 0.01050, requiring calculation
during report processing to resolve the opportunity to 10,500 Euros. Note that running the opportunity report on March
31st doesn't change the calculation and the close date of January 31st is used.

12
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The following figure describes an example of user preferred currency using advanced currency management.

Example of User Preferred Currency
using Advanced Currency Management:

Opportunity report on
March 31* shows all
opportunities in EUR

User updates and
saves or closes record
on January 31%

User runs opportunity
report on March 31

] ] User Preferred Currency
Opportunity Currency in i« EUR. INR to EUR Usgr prEfgrr-Ed currency
in EUR is shown in

INR = 1M
March 31* exchange rate
January 31 is 0.1050 = EUR 10,500 report as EUR 10,500

Exchange Rates
Jan 31% rate: USDto EUR = 0.75011 Mar 31% rate: USD o EUR = 0.75013
Jan 31% rate: INR to EUR = 0.01050 Mar 31% rate: INR to EUR = 0.01052

Jan 31% rate: INR to USD = 0.01401 Mar 31% rate: INR to USD = 0.01403

Why do | see amounts of zero in analyses?

Currency exchange rates might not be set up correctly. For example, you set EUR as your preferred currency in general
preferences, and corporate currency is USD. Amounts are displayed in EUR after conversion from USD at the current
exchange rate.

Map to Work Areas

Set Up the Reports and Analytics Panel Tab

The Reports and Analytics panel tab appears in many work areas, and shows analytics and reports related to the work
areas. You map and unmap the objects for a specific work area from the business intelligence (BI) catalog.

Your mapping changes for a work area apply to all users who have access to it.
Map and Remove Objects from Your Work Area

1. Expand the Reports and Analytics panel tab.

2. C(lick the Edit Settings icon.
You see all the analytics and reports that are currently mapped to your work area.
3. Click Select and Add.
4. Select the object in the catalog.
5. Click OK.
6. To remove any mapping, select the object and click Remove.
7. Click Save.
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Map and Remove Objects from Any Work Area

In the Setup and Maintenance work area, go to the Map Reports to Work Areas task.
Select the application of the work area you want to map to.

Select the work area.

Click Search and see all the reports that are currently mapped to that work area.

Click Select and Add.

Select the object in the catalog.

Click OK.

To remove any mapping, select the object and click Remove.

NV AUWN

Tip: Click Synchronize to remove all mappings to any objects that are no longer in the catalog. You
synchronize all work areas, not just the one you're mapping.

9. C(lick Save.

Related Topics
« Why can't | see analytics and reports when | edit settings for the Reports and Analytics panel tab?

« Why can't | see analytics and reports when mapping to work areas for the Reports and Analytics panel tab?
« Set Up Reports for Scheduling
» Update Existing Setup Data

Why can't | see analytics and reports when mapping to work areas
for the Reports and Analytics panel tab?

Either no analytics and reports are mapped to the work area you select on the Map Reports to Work Areas page, or you
don't have access to the mapped objects.

Similarly, when you're selecting an object to map, you can only see objects you have access to. Your administrator can
grant access to the objects or let someone with access map them.

- Assign you roles with access to the objects you want to map.

- Grant the Reports and Analytics Region Administration Duty to someone who already has access to the objects.

Why can't | see analytics and reports when | edit settings for the
Reports and Analytics panel tab?

In the Edit Settings window, you might not see a currently mapped report because you don't have access to it.

Similarly, when you're selecting an object to map, you can only see objects you have access to. Your administrator can
grant access to the objects or let someone with access map them.

- Assign you roles with access to the objects you want to map.

14
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- Grant the Reports and Analytics Region Administration Duty to someone who already has access to the objects.

Set Up Reports as Scheduled Processes

Create Job Definitions to Run Reports as Scheduled Processes

Every job definition has a job type that reflects the executable for the job, such as Java or Oracle Analytics Publisher
reports. You can only create job definitions that are based on Analytics Publisher reports.

When there's a job definition for an Analytics Publisher report, users can run the report as a scheduled process in the
Scheduled Processes work area. Otherwise, they can open reports (which are set up to be run online) elsewhere, for
example in the Reports and Analytics work area.

CAUTION: Make sure your user name doesn’t contain any spaces. If you create a custom job definition using a user
name that contains spaces, other users might get errors when they submit this custom job definition.

Create Job Definitions
Here's how you create a job definition for an Analytics Publisher report:

1. In the Setup and Maintenance work area, go to the Manage Enterprise Scheduler Job Definitions and Job
Sets task in the Application Extensions functional area. Or, depending on your offering, you might use a
different functional area.

Note: If you don't see the task, make sure that the Enterprise Scheduler Job Definitions and Job Sets feature
is enabled at the offering level.

N

On the Manage Enterprise Scheduler Job Definitions and Job Sets page, click the Manage Job Definitions tab.
3. Click the Create icon.
4. Fillin the Job Definition section.

Field or Check Box What You Do
Display Name Enter the name that users see and select to submit the scheduled process.
Name Enter a name with only alphanumeric characters, for example, AtkEssProgramsl. It can't have

spaces or any special characters.

Job Application Name Select the application to associate the job definition with. What you select depends on the task
you're using.

o Manage Enterprise Scheduler Job Definitions and Job Sets for Customer Relationship
Management and Related Applications: Select CrmEss.

o Manage Enterprise Scheduler Job Definitions and Job Sets for Financial, Supply Chain
Management, and Related Applications: Select FscmEss.

o Manage Enterprise Scheduler Job Definitions and Job Sets for Human Capital
Management and Related Applications task: Select EarHcmEss.
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Field or Check Box What You Do

Enable submission from Enterprise Make sure you don't select this check box.

Manager

Job Type Select BIPJobType. Don't select any other type.

Default Output Format Select the output format users get by default when they submit the scheduled process.

Report ID Enter the path to the report in the Bl catalog, starting with the folder within Shared Folders, for

6.

7.

example: Custom/<Family Name>/<Product Name>/<Report File Name>.xdo.

Make sure to include the . xdo file extension for the report definition.

Enable submission from Scheduled Leave the check box selected.
Processes

In the Parameters subtab, you can define parameters that are available to users when they submit the
scheduled process based on your job definition.

In the User Properties subtab, don't create or edit a user property unless you have the accurate information
that's required to create or edit one. The EXT_PortletContainerWebModule USer property is automatically created.

Click Save and Close.

When you create a job definition, a privilege with the same name as the job definition is automatically created with a
Run prefix. For example, for a job definition named MyProcess1, with display name My Process, the privilege code is
RUN_MYPROCESST, with Run My Process as the name. Make sure to use the Security Console to assign this privilege to
roles so that users who need to run the process can do so.

Related Topics

Define Parameters for Job Definitions
Update Existing Setup Data
Configure Offerings

Manage List of Values Sources

Edit Job Definitions

Define Parameters for Job Definitions

A parameter controls which records are included or how they are affected when a job runs. Job definitions can have one
or more parameters or none at all.

You define parameters while creating or editing job definitions using the Manage Enterprise Scheduler Job Definitions
and Job Sets page. In the Setup and Maintenance work area, use the following:

Functional Area: Application Extensions or a product-specific functional area
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When users run the scheduled process for job definitions of type BIPJobType, the values they enter for the parameters
determine the data to be included in the report. Also, the values are passed to the data model that the report is using.

The parameters that you define must be in the same order as parameters in the data model for the report. For example,
the data model has parameters in this order:

° P_START DATE
- P_END DATE
° P_CURRENCY
You create parameters as follows:
- Start Date
- End Date

« Currency

Defining Parameters: Job Definitions
To define parameters while creating or editing job definitions:

1. On the Manage Job Definitions page, open the Parameters sub tab.
2. Click Create.
3. Enter the parameter prompt that users see when they submit the scheduled process.
4. Select a data type and configure how the parameter and the data entered are displayed, as described in this
table.
Data Type Fields
Boolean Select this if you want the parameter to be a check box.
Select True or False to determine if the check box is selected or not.
Date or time Select Date and time or Date only option.
Select a value from the Default Date Format.
Note: Make sure the format you select here is the same as the format used for the job. If the
job definition type is BIPJobType, select yyyy-MM-dd, and make sure the data model for the
corresponding Oracle Analytics Publisher report is using the same date format.
Number Select a Number Format.
Select Left or Right for data alignment.
String Select a Page Element.

Select Text box if you want the user to provide a text.
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Data Type Fields

Select Choice list if you want a list with limited options (maximum 10). If there are more than
500 values, users will get an error when they try to set the parameter as part of submitting the
scheduled process.

Select List of values if you want a list with unlimited options with a search facility.

5. Select the Read Only check box if you don't want to enable users to set this parameter. When a parameter is set
as read only, the user is required to provide a default value to be passed to the job definition.

6. If you select list of values or choice list page element, select a List of Values Source and an Attribute. Use the
list of values sources from the Manage List of Values Sources tab. Don't define lists of values in the data model
that the report is using.

7. From the list of available attributes, select the attributes you want to appear in the list and move them to the
selected attributes section. These attributes determine the values that the user can see.

8. Define a Default Value for the parameter.

9. Inthe Tooltip Text field, provide additional information for the user to follow.

10. Select the Required check box if users must set this parameter to submit the scheduled process.
11. Select the Do not Display check box if users should not see this parameter while submitting the process.
12. Click Save and Create Another or Save and Close.

Dependent Parameters
The attributes of some parameters depend on the attributes or values of certain other parameters. The attributes of a
parameter would change if the value of its dependent parameter changes.

For example, you have three parameters, namely Country, State and, City. In this case, the value of the Country
parameter would determine the values available in the State parameter. The values in the State parameter would
determine the values available in the City parameter.

Related Topics
« Create Job Definitions to Run Reports as Scheduled Processes

- Define Dependent Parameters in Job Definitions

Set Up Reports for Scheduling

You can set up reports as scheduled processes so users can submit them from the Scheduled Processes and other work
areas.

If you want users to also submit these scheduled processes from the Reports and Analytics work area and panel tab,
then you need to configure properties for the corresponding reports.

Enable a Report for Scheduling

1. Inthe Reports and Analytics work area or panel tab, edit the report in the business intelligence catalog.
2. Click Properties.
3. Inthe General tab in the Properties dialog box, enter the field values as shown in this table and then click OK.
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Field Value

Enterprise Scheduler Job Package Name Enter the path for the job definition, for example: /oracle/apps/ess/<product family>/
<product>/<business area>/Jobs

Enterprise Scheduler Job Definition Name = Enter the job definition name (not display name), for example: ABCDEFG

Related Topics
- Set Up the Reports and Analytics Panel Tab

» How You Access and Modify Report Components
« Create Job Definitions to Run Reports as Scheduled Processes

Configure Deep Links

Register Business Intelligence to Support Deep Linking

Deep linking lets you to navigate from an analysis on the interface pages to specific attributes and objects in your work
areas so that you can work with them directly.

What does that mean? It means that if you're looking at an analysis on leads, for example, you can click a record on the
analytic and go edit the lead record on the edit object page. To support deep links, use the Setup and Maintenance work
area to register the Business Intelligence Server as a third-party application.

Register Business Intelligence Server as a Third-Party Application
To register the Bl Server:

Use the Manage Third Party Applications page.

Click Create.

Enter analyticsapp as the application name.

Enter the full URL for the Bl Server (for example: http: //host:port/analytics/saw.dll).
Enter analytics server as the Partner Name.

Click Save and Close.

cuhlhuNA

Related Topics
» Manage Integration of Additional Applications

Create Deep Links

Create deep links in your analytics that let you navigate from an analysis to specific attributes and objects in your
transactional pages to work with them directly.
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1

1n.
12.

OCwVvoOgouh

In the Reports and Analytics work area, click Browse Catalog.

Create or edit an analysis. Use a subject area that includes the attribute you want to link to in the transactional
pages, and ensure that you include the object ID.

On the Criteria tab, click the Options icon for the attribute column on which you need a deep link and select
Column Properties.

Open the Interaction tab in the Column Properties dialog box.

In the Primary Interaction list in the Value section, select Action Links to display the Action Links table.
Select the Do not display in a pop-up if only one action link is available at runtime option.

Click Add Action Link.

In the New Action Link dialog box, enter the link text for the navigation.

Click the Create New Action icon and select Navigate to a Web Page.

In the Create New Action dialog box, enter the URL to navigate to, which references parameters you define in
the prompt. For shared analyses://<hostname>/fscmUIl/faces/deeplink?objType=@{1}&objKey=<object
ID>=@{2}&action=@{3}&returnApp=AnalyticsApp&returnAppParams=PortalGo%26path=</shared/
Custom/<folder>/@{6}

Note: If you don't click the Return icon, remove parameters 5 through 7. In this case, the
URL would be: //<hostname>/fscmUIl/faces/deeplink?objType=@{1}&objKey=<object
ID>=@{2};searchind=@{3}&action=@{4}

For personal analyses stored in My Folders: //<hostname>/fscmUIl/faces/deeplink?
objType=@{1}&objKey=<object
ID>=@{2}&action=@{3}&returnApp=AnalyticsApp&returnAppParams=PortalGo%26pather=/users/
@{5}/ @{6}

Click Define Parameters to add corresponding parameters for the URL.

In the Define Parameters section, click Add Parameter to add the following mandatory parameters:

Name Prompt Type of Value Value Fixed Hidden Notes

1 Object Type Value <Object Type> Selected Selected Used for shared
and personal
analyses.

2 <Prompt Name> = Column Value Column Namein = Selected Selected Used for shared
"<table.name>" and personal
format analyses.

3 Action Value edit Selected Selected Used for shared
and personal
analyses.

4 returnApp Value AnalyticsApp Selected Selected Used for shared
and personal
analyses.
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Name Prompt Type of Value Value Fixed Hidden Notes

5 Logged in User Session Variable = USER Selected Selected Session variable

parameter used
for personal
analysis
permissions.

6 Report Name Value Analysis Name Selected Selected Used for shared
and personal
analyses. The
name of the
analysis to
return to after
working in the
transactional

page.

13. Click Options to set how the page opens.

14. In the Action Options dialog box, select Open in New Window to open the page in a new window.

15. Save your work.

16. If you have provided the Return Application name, a Return icon is available in the transactional page to return
to the analysis.

Related Topics
- Register Business Intelligence to Support Deep Linking

» Manage Analytics with Advanced Features

Deep Links for Procurement

You can use deep links to open pages without navigating through the menu structure.

When you add deep links to a business intelligence report or a company website, users can simply click those links to
go directly to the application pages they need to use, without any additional clicks or navigation. You can find all of the
available deep links in the Deep Links work area. Some deep links, such as those assigned the NONE action, are ready
to use as is. Other deep links, such as those assigned the VIEW action, require you to edit the link details before you can
use them.

This table lists Procurement deep links that are available in the Deep Links work area.

Product Deep Link (Object Short Description of ObjKey Needed? (Y/ Name and ObjKey Parameter
Type, Action) Purpose N) Description of Values
ObjKey Parameter
Oracle Purchasing View Order Opens a specific Y PO_HEADER_ID: PO_HEADER_ID
purchase order for Unique identifier of a =~ column in the PO_
(PURCHASE_ORDER, viewing on the View purchasing document. HEADERS_ALL table.
Order page.
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Product

Oracle Purchasing

Oracle Purchasing

Oracle Purchasing

Oracle Purchasing

Oracle Sourcing

Oracle Sourcing

Oracle Sourcing

ORACLE

Deep Link (Object
Type, Action)

VIEW)

View Order
PURCHASE_ORDER,
NONE

View Order
(PURCHASE_ORDER_

LOBUSER,NONE)

View Order

(PURCHASE_ORDER_
APUSER,NONE)

View Agreement
(PURCHASE_AGREE
MENT,VIEW)

View Agreement
(PURCHASE_AGREE

MENT,NONE)

View Order
(PURCHASE_ORDER _
REQUESTER,NONE)
View Negotiation

(NEGOTIATION,VIEW)

Manage Negotiations

(NEGOTIATION,NONE)

View Negotiation
(NEGOTIATION_

SUPPLIERUSER,VIEW)

Short Description of ObjKey Needed? (Y/
Purpose N)

Opens a specific Y
purchase order for
viewing on the View
Order page.

Opens a specific Y
purchase order for
viewing on the View
Order page in the

Invoice work area.

Opens a specific Y
purchase agreement

for viewing on the

View Agreement page.

Opens a specific Y
purchase order for
viewing on the View
Order page.

Opens a specific Y
negotiation on the

View Negotiation

page.

Opens the Manage N
Negotiations page in

the Procurement work
area.

Opens a specific Y
negotiation on the

View Negotiation page

in the Supplier portal.

Chapter 2

Setup and Management

Name and
Description of
ObjKey Parameter

PO_HEADER_ID:
Unique identifier of a
purchasing document.

PO_HEADER_ID:
Unique identifier of a
purchasing document.

PO_HEADER_ID:
Unique identifier of a
purchasing document.

PO_HEADER_ID:
Unique identifier of a
purchasing document.

AUCTION_HEADER_
ID: Unique identifier of
a negotiation.

N/A

AUCTION_HEADER_
ID: Unique identifier of
a negotiation.

ObjKey Parameter
Values

PO_HEADER_ID
column in the PO_
HEADERS_ALL table.

PO_HEADER_ID
column in the PO_
HEADERS_ALL table.

PO_HEADER_ID
column in the PO_
HEADERS_ALL table.

PO_HEADER_ID
column in the PO_
HEADERS_ALL table.

AUCTION_HEADER_
ID column in the PON_
AUCTION_HEADERS_
ALL table.

N/A

AUCTION_HEADER_
ID column in the PON_
AUCTION_HEADERS_
ALL table.
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Product

Oracle Sourcing

Oracle Supplier Model

Oracle Supplier Model

Oracle Supplier
Qualification

Oracle Supplier
Quialification

Oracle Supplier
Quialification

Oracle Supplier
Quialification

ORACLE

Deep Link (Object
Type, Action)

Active Negotiations
(NEGOTIATION_

SUPPLIERUSER,NONE)

View Supplier
(SUPPLIER,VIEW)
View Supplier

(SUPPLIER,NONE)

View Supplier
(SUPPLIER_POUSER,
VIEW)

View Supplier
(SUPPLIER_POUSER,

NONE)

View Qualification
(QUALIFICATION,
VIEW)

Manage Qualifications

(QUALIFICATION,
NONE)

View Assessment

(ASSESSMENT,VIEW)

Manage Assessments

(ASSESSMENT,NONE)

Short Description of
Purpose

Opens the Active
Negotiations page in
the Supplier portal.

Opens a specific
supplier on the View
Supplier page.

Opens a specific
supplier on the View
Supplier page in the

Purchasing work area.

Opens a specific
qualification on the
View Qualification
page.

Opens the Manage
Quialifications page
in the Supplier
Qualification work
area.

Opens a specific
assessment on the
View Assessment

page.

Opens the Manage
Assessment page
in the Supplier
Quialification work
area.

ObjKey Needed? (Y/
N)

Chapter 2

Setup and Management

Name and
Description of
ObjKey Parameter

N/A

SupplierNumber:
Number that uniquely
identifies the supplier.

SupplierName: Name
of the supplier.

SupplierNumber:
Number that uniquely
identifies the supplier.

SupplierName: Name
of the supplier.

QUALIFICATIONS_ID:
Unique identifier of
the qualification.

N/A

ASSESSMENT_ID:

Unique identifier of
the assessment.

N/A

ObjKey Parameter
Values

N/A

SupplierNumber

SEGMENT1 column in
the POZ_SUPPLIERS
table.

SupplierName
PARTY_NAME column

in the HZ_PARTIES
table.

SupplierNumber

SEGMENT1 column in
the POZ_SUPPLIERS
table.

SupplierName
PARTY_NAME column

in the HZ_PARTIES
table.

QUALIFICATIONS_ID
column in the POQ_
QUALIFICATIONS
table.

N/A

ASSESSMENT_ID
column in the POQ_
ASSESSMENTS table.

N/A
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Product

Oracle Supplier
Qualification

Oracle Supplier
Quialification

Oracle Self Service
Procurement

Oracle Self Service
Procurement

Oracle Self Service
Procurement

Oracle Self Service
Procurement

Deep Link (Object
Type, Action)

View Initiative

(INITIATIVE,VIEW)

Manage Initiatives

(INITIATIVE,NONE)

View Requisition Lines
(PURCHASE_REQUIS

ITION_PRCAGENT,
NONE)

View Requisition
Details
(PURCHASE_REQUIS

ITION_PRCAGENT,
VIEW)

View Requisition
Details
(PURCHASE_

REQUISITION_
LOBUSER,VIEW)

Manage Requisitions

(PURCHASE_REQUIS

ITION_LOBUSER,
NONE)

Short Description of
Purpose

Opens a specific
initiative on the View
Initiative page.

Opens the Manage
Initiative page in the
Supplier Qualification
work area.

Opens the View
Requisition Lines page
in the Purchasing
work area so that the
user can search for a
requisition line.

Opens a specific
requisition for
viewing on the View
Requisition Details
page.

Opens a specific
requisition for
viewing on the View
Requisition Details

page.

Opens the Manage
Requisition page

in the Self Service
Procurement work
area so that the user
can search for a
requisition.

Chapter 2
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ObjKey Needed? (Y/ Name and

N) Description of
ObjKey Parameter

Y Initiativeld: Unique
identifier of the
initiative.

N N/A

N N/A

Y REQUISITION_
HEADER_ID: Unique
identifier of a
requisition.

Y REQUISITION_
HEADER_ID: Unique
identifier of a
requisition.

N N/A

ObjKey Parameter
Values

INITIATIVE_ID
column in the POQ_
INITIATIVES table.

N/A

N/A

REQUISITION_
HEADER_ID

column in the POR_
REQUISITION_
HEADERS_ALL table.

REQUISITION_
HEADER_ID

column in the POR_
REQUISITION_
HEADERS_ALL table.

N/A

Note: In Purchasing and Supplier Model, deep links that have NONE or VIEW action, open a specific page and need

an ObjKey.

This table lists the target audience and security requirements for different Procurement deep links.

Deep Link (Object Type, Action)

View Order

Buyer

(PURCHASE_ORDER,VIEW)

ORACLE

Target Audience

Security Requirements

Function Security:

View Purchase Order

Examples

https://
pod.oraclecloud. com/
fndSetup/faces/deeplink?
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Deep Link (Object Type, Action)
View Order

(PURCHASE_ORDER,NONE)

View Order

(PURCHASE_ORDER_

Target Audience

Purchase Analyst

Security Requirements

- View Purchase Order Work
Area

Data Security:

- Procurement Agent Access

Function Security:

- View Purchase Order

Examples

objType=PURCHASE _
ORDER&objKey=poHeaderId=1llllllé&act:

https://

pod.oraclecloud.com/
fndSetup/faces/deeplink?
objType=PURCHASE _
ORDER&objKey=poHeaderId=111111

https://
pod.oraclecloud. com/
fndSetup/faces/deeplink?
objType=PURCHASE_ORDER _

LOBUSER,NONE) + View Purchase Order Work LOBUSER&objKey=poHeaderId=111111
Area
Data Security:
- Requisitioning business units
for which they're authorized
- For the financial business unit
associated with their primary
assignment
View Order AP Specialist Function Security: https://
pod.oraclecloud.com/
(PURCHASE_ORDER_APUSER, . View Purchase Order fndSetup/faces/deeplink?
) ) objType=PURCHASE_ORDER _
NONE) - View Invoice Work Area APUSER&objKey=poHeaderId=111111
Data Security:
- Bill-to business units for
which they're authorized
View Agreement Buyer Function Security: https://
pod.oraclecloud.com/
(PURCHASE_AGREEMENT,VIEW) . View Purchase Agreement fndSetup/faces/deeplink?
. objType=PURCHASE _
View Agreement - View Purchase Agreement AGREEMENT &objKey=poHeaderId=111111.
Work Area
(PURCHASE_AGREEMENT,NONE) Data Security: https://
pod.oraclecloud.com/
fndSetup/faces/deeplink?
Procurement Agent Access ob3Type=PURCHASE _
AGREEMENT&objKey=poHeaderId=111111
View Order Requester Function Security: https://

(PURCHASE_ORDER_REQUESTER,
NONE)

ORACLE

- Manage Requisitions

- View PO as Requester OR
View PO

- View Requisition All
Data Security:

« Requisitioning business units
for which they're authorized

pod.oraclecloud.com/
fndSetup/faces/deeplink?
objType=PURCHASE_ORDER _
REQUESTER&objKey=poHeaderId=111111
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Deep Link (Object Type, Action)  Target Audience Security Requirements Examples

- If the user has View
Requisition All privilege, then
they have access to all POs
for the authorized BUs else
they need to be a requester or

preparer
View Negotiation Category Manager/ Sourcing Function Security: https://
Project Collaborator pod.oraclecloud.com/
(NEGOTIATION,VIEW) . View Supplier Negotiation fndSetup/faces/deeplink?
Work Area objType=NEGOTIATION&action=VIEW&oD:

- View Supplier Negotiation

Data Security:

- Negotiation owner (Category
manager), or

- A member of the
Collaboration team, or

- An active agent for the
procurement business unit
with access to manage
negotiations and is allowed to
have VIEW or FULL access to
other agents documents

Manage Negotiations Category Manager/ Sourcing Function Security: https://
Project Collaborator pod.oraclecloud.com/
(NEGOTIATION,NONE) . View Supplier Negotiation fndSetup/faces/deeplink?
Work Area objType=NEGOTIATION&action=NONE

Data Security:

- Negotiation owner (Category
manager), or

- A member of the
Collaboration team, or

- An active agent for the
procurement business unit
with access to manage
negotiations and is allowed to
have VIEW or FULL access to
other agents documents

View Negotiation Supplier Bidder Function Security: https://
pod.oraclecloud.com/
(NEGOTIATION_SUPPLIERUSER, . View Supplier Negotiation fndSetup/faces/deeplink?
objType=NEGOTIATION
VIEW) + Access Suppliers Work Area  SUPPLIERUSER&action=VIEW&objKey=Au
Overview

Data Security:

- Supplier Data Access

- Negotiation Response Rule to
Restrict to Invited Suppliers
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Deep Link (Object Type, Action)

Active Negotiations
(NEGOTIATION_SUPPLIERUSER,

NONE)

View Supplier
(SUPPLIER,VIEW)
View Supplier

(SUPPLIER,NONE)

View Supplier
(SUPPLIER_POUSER,VIEW)
View Supplier

(SUPPLIER_POUSER,NONE)

View Qualification

(QUALIFICATION,VIEW)

Manage Qualifications

(QUALIFICATION,NONE)

ORACLE

Target Audience

Supplier Bidder

Security Requirements

Function Security:

.

Supplier Administrator/ Manager

.

Buyer

Supplier Qualification Manager

.

View Supplier Negotiation

Access Suppliers Work Area
Overview

Function Security:

Suppliers Work Area

View or Maintain Supplier

Function Security:

View or Maintain Supplier

View Purchase Order Work
Area

Function Security:

View Supplier Qualification

View Supplier Qualification
Work Area

Data Security:

.

Supplier Qualification Manager

.

Quialification owner, or

A member of the Evaluation
team or,

An active agent for the
procurement business unit
with access to manage
supplier qualifications and
is allowed to have VIEW or
FULL access to other agents
documents

Function Security:

Search Supplier Qualification

View Supplier Qualification
Work Area

Data Security:

Chapter 2
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Examples

https://
pod.oraclecloud.com/
fndSetup/faces/deeplink?
objType=NEGOTIATION
SUPPLIERUSER&action=NONE

https://

pod.oraclecloud. com/
fndSetup/faces/deeplink?
objType=SUPPLIER&objKey=supplierNur

https://

pod.oraclecloud. com/
fndSetup/faces/deeplink?
objType=SUPPLIER&objKey=supplierNar
Corporation

https://

pod.oraclecloud. com/
fndSetup/faces/deeplink?
objType=SUPPLIER _
POUSER&objKey=supplierNumber=11111

https://

pod.oraclecloud. com/
fndSetup/faces/deeplink?
objType=SUPPLIER _
POUSER&objKey=supplierName=Vision
Corporation

https://

pod.oraclecloud.com/
fndSetup/faces/deeplink?
objType=QUALIFICATION&objKey=quali

https://

pod.oraclecloud.com/
fndSetup/faces/deeplink?
objType=QUALIFICATION&action=NONE
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View Assessment

(ASSESSMENT,VIEW)

Manage Assessments

(ASSESSMENT,NONE)

View Initiative

(INITIATIVE,VIEW)

Manage Initiatives

(INITIATIVE,NONE)

ORACLE

Target Audience

Supplier Qualification Manager

Supplier Qualification Manager

Supplier Qualification Manager

Supplier Qualification Manager

Security Requirements

- An active agent for the
procurement business unit

Function Security:

- View Supplier Assessment

- View Supplier Qualification
Work Area

Data Security:

- Assessment owner, or

- A member of the Evaluation
team or,

- An active agent for the
procurement business unit
with access to Manage
Supplier Qualifications and
is allowed to have VIEW or
FULL access to other agents
documents

Function Security:

- Search Supplier Assessment

- View Supplier Qualification
Work Area

Data Security:

- An active agent for the
procurement business unit

Function Security:

- View Supplier Qualification
Initiative

- View Supplier Qualification
Work Area

Data Security:

- Initiative owner, or

- A member of the Evaluation
team or,

- An active agent for the
procurement business unit
with access to Manage
Supplier Qualifications and
is allowed to have VIEW or
FULL access to other agents'
documents.

Function Security:

- Search Supplier Qualification
Initiative

Chapter 2
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Examples

https://

pod.oraclecloud.com/
fndSetup/faces/deeplink?
objType=ASSESSMENT&objKey=assessmel

https://

pod.oraclecloud.com/
fndSetup/faces/deeplink?
objType=ASSESSMENT&action=NONE

https://

pod.oraclecloud. com/
fndSetup/faces/deeplink?
objType=INITIATIVE&objKey=initiati:

https://

pod.oraclecloud. com/
fndSetup/faces/deeplink?
objType=INITIATIVE&action=NONE
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View Requisition Lines
(PURCHASE_REQUISITION_

PRCAGENT,NONE)

View Requisition Details
(PURCHASE_REQUISITION_

PRCAGENT,VIEW)

View Requisition Details
(PURCHASE_REQUISITION_

LOBUSER,VIEW)

Manage Requisitions
(PURCHASE_REQUISITION_

LOBUSER,NONE)

Target Audience

Procurement Agent Running OTBI
Reports

Procurement Agent Running OTBI
Reports

Line of Business User Running
OTBI Reports

Line of Business User Running
OTBI Reports

Security Requirements

- View Supplier Qualification
Work Area

Data Security:

- An active agent for the
procurement business unit.

Function Security:

- View Requisitions

Data Security:

- Procurement Agent Access

Function Security:

«  Purchase Order Work Area
- View Requisition (As Buyer)
Data Security:

«  Procurement Agent Access

Function Security:

- Manage Requisitions

Data Security:

«  Purchase Analysis, Manage
User Data Access, and
Primary BU

Function Security:

- Manage Requisitions

Data Security:

- Manage User Data Access

Chapter 2
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Examples

https://
pod.oraclecloud.com/
fndSetup/faces/deeplink?
objType=PURCHASE _
REQUISTITION_
PRCAGENT&action=NONE

https://

pod.oraclecloud. com/
fndSetup/faces/deeplink?
objType=NEGOTIATION&objKey=requisi:

https://

pod.oraclecloud.com/
fndSetup/faces/deeplink?
objType=PURCHASE _

REQUISTITION_
LOBUSER&objKey=requisitionHeaderId:

https://
pod.oraclecloud.com/
fndSetup/faces/deeplink?
objType=PURCHASE _
REQUISITION_
LOBUSER&action=NONE

To know how to construct deep links to purchasing transactions from analyses and reports, refer to the Navigating to
Purchasing Transactions from Reports white paper that's available on My Oracle Support (Document ID 2444555.1).

To know how to construct deep links to supplier profiles from analyses and reports, refer to the Navigating to Supplier
Profile from Reports white paper that's available on My Oracle Support (Document ID 2556026.1).

FAQs for Deep Links

Why did a deep link open to a blank page?

You may not have access to the linked object, or the URL entered for the action is incorrect, for example lacking the
environment or the Object ID name.
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- Check the URL you entered for the action. It may be missing the environment name or the Object ID name.

- Check the URL parameters, the spelling of the action, and that you're using the correct key in the object's
analysis.

Do | have to display the ID for my object?

No, you can add it, format the column as a number with zero decimals, and then hide the column.

Can | display actions for some users and not others?
Yes, you define conditions for the action to display.

Manage Permissions

Manage Catalog Permission

You may want to remove access to predefined catalog folders so that those associated with offerings you don't use
aren't displayed. You can hide the entire predefined catalog or selectively display root catalog folders for offerings.

To control which offerings are available, create a custom role based on the Custom Bl Web cat Reporting Duty role and
its associated roles for each. Using custom roles, you can manage folder access in a number of ways, depending on
requirements and previous modifications you have made.

- Add duty roles for parent folders to the custom role so that all users see a subset of the predefined catalog. Add
roles only for the offerings you want to retain access for.

Don't add any catalog reporting duty roles for any offerings to the custom role to hide the entire predefined
catalog and display only /Shared/Custom folders. For example, you can remove Bl catalog access for external
users such as partners who have no access to reporting.

Delete all catalog reporting duty roles from the custom role. Also, add catalog reporting duty roles to a new or
existing job role so that job roles with Bl access get default access to the predefined catalog. For example, by
default, Financial job roles have access to Financial reporting content but Human Capital Management job roles
don't have access to the predefined HCM BI catalog. You can grant the Human Capital Management Folder
Reporting Duty role to new job roles to allow access to predefined HCM reports.

Hide Predefined Catalog Folders

All authenticated users have the Custom Bl Web cat Reporting Duty role, which inherits all of the folder reporting roles
that determine access and visibility of root level catalog folders. Administrators with IT Security Manager privileges can
hide predefined folders by creating custom roles based on this role and their associated roles from the duty role.

1. Open the Security Console.

Search for Custom Bl Web cat Reporting Duty and review its duty roles to determine which to retain in your
custom role.

Create a custom role.

Click Actions > Add Role.

Click Next twice to navigate to the Role Hierarchy step.

To hide all folders, leave the hierarchy empty. Add any roles for offerings you want to retain access for.

N
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30
ORACLE



Oracle Fusion Cloud Procurement

Creating and Administering Analytics and Reports for

Procurement

Chapter 2
Setup and Management

7. Run the Import User and Role Application Security Data process to synchronize security changes.
8. Click Browse Catalog in the Reports and Analytics work area and click Administration. In the Maintenance and
Troubleshooting section, select Reload Files and Metadata to refresh the the Bl cache.

Bl Reporting Roles

This table shows the mapping between shared root catalog folders, folder reporting roles, and job roles.

Catalog Folder
/Shared/Common Content
/Shared/Customer Data

Management

/Shared/Enterprise Contracts

/Shared/Extension

/Shared/Financials

ORACLE

Duty Role

BI_COMMON_CONTENT_
REPORTING_DUTY

BI_CDM_REPORTING_DUTY

BI_OKC_REPORTING_DUTY

BI_EXT_REPORTING_DUTY

BI_FIN_REPORTING_DUTY

Duty Role Name

Common Content Folder Reporting
Duty

Customer Data Management
Folder Reporting Duty

Enterprise Contracts Folder
Reporting Duty

Extension Folder Reporting Duty

Financials Folder Reporting Duty

Associated Job Roles

None

None

ORA_OKC_CUSTOMER_
CONTRACT_ADMINISTRATOR_
JOB, ORA_OKC_CUSTOMER_
CONTRACT_MANAGER_JOB, ORA_
OKC_CUSTOMER_CONTRACT_
TEAM_MEMBER_ABSTRACT, ORA_
OKC_ENTERPRISE_CONTRACT_
ADMINISTRATOR_JOB, ORA_
OKC_ENTERPRISE_CONTRACT_
MANAGER_JOB, ORA_OKC_
ENTERPRISE_CONTRACT_TEAM_
MEMBER_ABSTRACT, ORA_
OKC_SUPPLIER_CONTRACT_
ADMINISTRATOR_JOB, ORA_
OKC_SUPPLIER_CONTRACT_
MANAGER_JOB, ORA_OKC_
SUPPLIER_CONTRACT_TEAM_
MEMBER_ABSTRACT

None

ORA_AP_ACCOUNTS_PAYABLE_
INVOICE_SUPERVISOR_

JOB ORA_AP_ACCOUNTS_
PAYABLE_MANAGER_JOB, ORA_
AP_ACCOUNTS_PAYABLE_
PAYMENT_SUPERVISOR_

JOB, ORA_AP_ACCOUNTS_
PAYABLE_SPECIALIST_JOB,
ORA_AP_ACCOUNTS_PAYABLE_
SUPERVISOR_JOB, ORA_AR_
ACCOUNTS_RECEIVABLE_
MANAGER_JOB, ORA_AR_
ACCOUNTS_RECEIVABLE_
MANAGER_SOD_JOB, ORA_
AR_ACCOUNTS_RECEIVABLE_
SPECIALIST_JOB, ORA_AR_
ACCOUNTS_RECEIVABLE_
SPECIALIST_SOD_JOB, ORA_
AR_BILLING_MANAGER_JOB,
ORA_AR_BILLING_SPECIALIST_
JOB, ORA_CE_CASH_MANAGER_
JOB, ORA_EXM_EXPENSE_
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Catalog Folder

/Shared /Higher Education

/Shared/Human Capital
Management

/Shared/Incentive
Compensation

/Shared/Loyalty

/Shared/Manufacturing

/Shared/Marketing

ORACLE

Duty Role

BI_HED_REPORTING_DUTY

BI_HCM_REPORTING_DUTY

BI_IC_REPORTING_DUTY

BI_LOY_REPORTING_DUTY

BI_MFG_REPORTING_DUTY

BI_MKT_REPORTING_DUTY

Duty Role Name

Higher Education Folder Reporting
Duty

Human Capital Management
Folder Reporting Duty

Incentive Compensation Folder
Reporting Duty

Loyalty Folder Reporting Duty

Manufacturing Folder Reporting
Duty

Marketing Folder Reporting Duty

Chapter 2
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Associated Job Roles

MANAGER_JOB, ORA_FA_ASSET_
ACCOUNTANT_JOB, ORA_FA_
ASSET_ACCOUNTING_MANAGER_
JOB, ORA_FUN_INTERCOMPANY_
ACCOUNTANT_JOB, ORA_GL_
FINANCIAL_ANALYST_JOB,
ORA_VRM_REVENUE_ANALYST_
JOB, ORA_VRM_REVENUE_
MANAGER_JOB, ORA_XCC_
BUDGET_MANAGER_JOB

ORA_HEQ_ADMISSIONS_
COORDINATOR_JOB, ORA_
HEQ_ADMISSIONS_MANAGER_
JOB, ORA_HER_ACADEMIC_
COORDINATOR_JOB, ORA_
HER_REGISTRAR_JOB, ORA_
HES_BURSAR_JOB, ORA_HEY_
STUDENT_SERVICES_MANAGER_
JOB, ORA_HEY_STUDENT_
SUPPORT_ADVISOR_JOB

By default, predefined HCM job
roles have no access to the the
predefined content.

ORA_CN_INCENTIVE_
COMPENSATION_ANALYST_
JOB, ORA_CN_INCENTIVE_
COMPENSATION_MANAGER_
JOB, ORA_CN_INCENTIVE_
COMPENSATION_PARTICIPANT_
ABSTRACT, ORA_CN_INCENTIVE_
COMPENSATION_PARTICIPANT_
MANAGER_ABSTRACT, ORA_CN_
INCENTIVE_COMPENSATION_
PLAN_ADMINISTRATOR_JOB

ORA_LOY_LOYALTY_MARKETING_
MANAGER_JOB, ORA_
LOY_LOYALTY_PROGRAM_
ADMINISTRATOR_JOB

ORA_CSE_ASSET_
ADMINISTRATOR_JOB

ORA_MKL_SALES_LEAD_
QUALIFIER_JOB, ORA_MKT_
CORPORATE_MARKETING_
MANAGER_JOB, ORA_MKT_
MARKETING_ANALYST_JOB, ORA_
MKT_MARKETING_MANAGER_
JOB, ORA_MKT_MARKETING_
OPERATIONS_MANAGER_JOB,
ORA_MKT_MARKETING_VP_JOB
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Catalog Folder Duty Role
/Shared/Partner BI_ZPM_REPORTING_DUTY
/Shared /Procurement BI_PRC_REPORTING_DUTY
/Shared/Projects BI_PRJ_REPORTING_DUTY

ORACLE

Duty Role Name

Partner Folder Reporting Duty

Procurement Folder Reporting
Duty

Projects Folder Reporting Duty

Chapter 2
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Associated Job Roles

ORA_ZPM_CHANNEL_ACCOUNT_
MANAGER_JOB, ORA_ZPM_
CHANNEL_ADMINISTRATOR_

JOB, ORA_ZPM_CHANNEL _
OPERATIONS_MANAGER_JOB,
ORA_ZPM_CHANNEL_PARTNER_
MANAGER_JOB, ORA_ZPM_
CHANNEL_PARTNER_PORTAL_
ADMINISTRATOR_JOB, ORA_ZPM_
CHANNEL_SALES_DIRECTOR_JOB,
ORA_ZPM_CHANNEL_SALES_
MANAGER_JOB

ORA_AP_ACCOUNTS_PAYABLE_
MANAGER_JOB, ORA_AP_
ACCOUNTS_PAYABLE_
SPECIALIST_JOB, ORA_
AP_ACCOUNTS_PAYABLE_
SUPERVISOR_JOB, ORA_
PO_BUYER_JOB, ORA_PO_
PROCUREMENT_APPLICATION_
ADMIN_JOB, ORA_PO_
PROCUREMENT_INTEGRATION_
SPECIALIST_JOB, ORA_
PO_PURCHASE_ANALYSIS_
ABSTRACT, ORA_POQ_SUPPLIER_
QUALIFICATION_DISCRETIONARY,
ORA_POR_PROCUREMENT_
REQUESTER_ABSTRACT, ORA_
POZ_SUPPLIER_ADMINISTRATOR_
ABSTRACT, ORA_POZ_SUPPLIER_
MANAGER_ABSTRACT

ORA_OKC_CUSTOMER_
CONTRACT_ADMINISTRATOR_
JOB, ORA_OKC_CUSTOMER_
CONTRACT_MANAGER_JOB, ORA_
OKC_CUSTOMER_CONTRACT_
TEAM_MEMBER_ABSTRACT, ORA_
OKC_ENTERPRISE_CONTRACT_
ADMINISTRATOR_JOB, ORA_
OKC_ENTERPRISE_CONTRACT_
MANAGER_JOB, ORA_OKC_
ENTERPRISE_CONTRACT_TEAM_
MEMBER_ABSTRACT, ORA_
PJF_GRANTS_ACCOUNTANT_
JOB, ORA_PJF_GRANTS_
ADMINISTRATOR_JOB, ORA_
PJF_GRANTS_DEPARTMENT_
ADMINISTRATOR_JOB, ORA_
PJF_PROJECT_ACCOUNTANT_
JOB, ORA_PJF_PROJECT_
ADMINISTRATOR_JOB, ORA_PJF_
PROJECT_BILLING_SPECIALIST_
JOB, ORA_PJF_PROJECT_
EXECUTION_ABSTRACT, ORA_
PJF_PROJECT_EXECUTIVE_

JOB, ORA_PJF_PROJECT_
INTEGRATION_SPECIALIST_

JOB, ORA_PJF_PROJECT_
MANAGEMENT_DUTY_ABSTRACT,
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Catalog Folder

/Shared/Public Sector

/Shared/Risk Management

/Shared/Sales

ORACLE

Duty Role

BI_PSC_REPORTING_DUTY

BI_GRC_REPORTING_DUTY

BI_ZBS_REPORTING_DUTY

Duty Role Name

Public Sector Folder Reporting
Duty

Risk Management Folder Reporting
Duty

Sales Folder Reporting Duty
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Associated Job Roles

ORA_PJF_PROJECT_MANAGER_
JOB, ORA_PJF_PROJECT_TEAM_
MEMBER_ABSTRACT, ORA_
PJF_PROJECTS_APPLICATION_
ADMINISTRATOR_JOB, ORA_PJF_
RESOURCE_MANAGER_JOB, ORA_
PJF_TEAM_COLLABORATOR_
ABSTRACT

ORA_PSC_AGENCY_STAFF_
ABSTRACT, ORA_PSC_BUILDING_
INSPECTOR_JOB, ORA_PSC_
BUSINESS_ANALYST_JOB,
ORA_PSC_CHIEF_BUILDING_
OFFICER_JOB, ORA_PSC_
ECONOMIC_DEV_OFFICER_JOB,
ORA_PSC_FINANCE_ADMIN_
JOB, ORA_PSC_INSPECTIONS_
SUPERVISOR_JOB, ORA_PSC_
PERMIT_TECHNICIAN_JOB, ORA_
PSC_PERMITS_APPLICATION_
ADMINISTRATOR_JOB, ORA_PSC_
PERMITS_SUPERVISOR_JOB, ORA_
PSC_PLAN_COORDINATOR_JOB,
ORA_PSC_PLAN_REVIEWER_
JOB, ORA_PSC_PRINCIPAL _
PLANNER_JOB, ORA_PSC_
SYSTEM_ADMINISTRATOR_JOB

ORA_GTG_APPLICATION_
ACCESS_AUDITOR_JOB, ORA_
GTG_APPLICATION_CONTROL _
MANAGER_JOB, ORA_GTG_
COMPLIANCE_MANAGER_JOB,
ORA_GTG_ENTERPRISE_RISK _
AND_CONTROL_MANAGER_JOB,
ORA_GTG_RISK_MANAGEMENT_
AUDITOR_JOB, ORA_GTR_
USER_ACCESS_CERTIFICATION_
MANAGER_JOB

ORA_ZBS_SALES_
ADMINISTRATOR_JOB, ORA_ZBS_
SALES_MANAGER_JOB, ORA_
ZBS_SALES_REPRESENTATIVE_
JOB, ORA_ZBS_SALES_
RESTRICTED_USER_JOB, ORA_
ZBS_SALES_VP_JOB, ORA_
ZPM_CHANNEL_ACCOUNT_
MANAGER_JOB, ORA_ZPM_
CHANNEL_ADMINISTRATOR_

JOB, ORA_ZPM_CHANNEL _
OPERATIONS_MANAGER_JOB,
ORA_ZPM_CHANNEL_PARTNER_
MANAGER_JOB, ORA_ZPM_
CHANNEL_PARTNER_PORTAL_
ADMINISTRATOR_JOB, ORA_ZPM_
CHANNEL_SALES_DIRECTOR_JOB,
ORA_ZPM_CHANNEL_SALES_
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Catalog Folder

/Shared/Service

/Shared/Subscription
Management

/Shared/Supply Chain
Management

ORACLE

Duty Role

BI_SVC_REPORTING_DUTY

BI_OSS_REPORTING_DUTY

BI_SCM_REPORTING_DUTY

Duty Role Name

Service Folder Reporting Duty

Subscription Management Folder
Reporting Duty

Supply Chain Management Folder
Reporting Duty
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Associated Job Roles

MANAGER_JOB, ORA_ZSP_SALES_
ANALYST_JOB

ORA_CSO_KNOWLEDGE_
ANALYST_JOB, ORA_CSO_
KNOWLEDGE_MANAGER_

JOB, ORA_SVC_CUSTOMER_
SERVICE_MANAGER_JOB, ORA_
SVC_CUSTOMER_SERVICE_
REPRESENTATIVE_JOB, ORA_
SVC_HUMAN_RESOURCE_HELP_
DESK_ADMINISTRATOR_JOB,
ORA_SVC_HUMAN_RESOURCE_
HELP_DESK_AGENT_JOB, ORA_
SVC_HUMAN_RESOURCE_HELP_
DESK_MANAGER_JOB, ORA_
SVC_INTERNAL_HELP_DESK_
ADMINISTRATOR_JOB, ORA_SVC_
INTERNAL_HELP_DESK_AGENT_
JOB, ORA_SVC_INTERNAL_HELP_
DESK_MANAGER_JOB, ORA_
ZBS_SALES_ADMINISTRATOR_
JOB, ORA_ZCA_CUSTOMER_
RELATIONSHIP_MANAGEMENT_
APPLICATION_ADMINISTRATOR_
JoB

ORA_OSS_SUBSCRIPTION_
SPECIALIST_JOB

ORA_ACD_PRODUCT_DESIGN_
ENGINEER_JOB, ORA_ACD_
PRODUCT_DESIGN_MANAGER_
JOB, ORA_ACE_PRODUCT_
MANAGEMENT_VP_JOB, ORA_
ACE_PRODUCT_PORTFOLIO_
MANAGER_JOB, ORA_CMF_
FISCAL_DOCUMENT_SPECIALIST_
JOB, ORA_CMF_RECEIVING_
SPECIALIST_JOB, ORA_CMR_
RECEIPT_ACCOUNTING_
DISCRETIONARY, ORA_CSE_
ASSET_ADMINISTRATOR_JOB,
ORA_CST_COST_ACCOUNTANT_
JOB, ORA_DOO_ORDER_
ADMINISTRATOR_JOB, ORA_
DOO_ORDER_MANAGER_JOB,
ORA_EGI_PRODUCT_DATA_
STEWARD_JOB, ORA_EGP_
PRODUCT_MANAGER_JOB, ORA_
ENQ_QUALITY_ANALYST_JOB,
ORA_ENQ_QUALITY_ENGINEER_
JOB, ORA_FOS_SUPPLY_CHAIN_
CONTROLLER_JOB, ORA_
INV_INVENTORY_MANAGER_
JOB, ORA_INV_WAREHOUSE_
MANAGER_JOB, ORA_MNT_
MAINTENANCE_MANAGER_JOB,
ORA_MNT_MAINTENANCE_
TECHNICIAN_JOB, ORA_MSC_
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Catalog Folder Duty Role Duty Role Name Associated Job Roles

BACKLOG_MANAGER_JOB, ORA_
MSC_DEMAND_AND_SUPPLY_
PLANNER_JOB, ORA_MSC_
DEMAND_PLANNER_JOB, ORA_
MSC_MATERIALS_PLANNER_JOB,
ORA_MSC_REPLENISHMENT_
PLANNER_JOB, ORA_MSC_SALES_
AND_OPERATIONS_PLANNER_
JOB, ORA_MSC_SUPPLY_CHAIN_
PLANNER_JOB, ORA_RCL_FIELD_
SERVICE_ADMINISTRATOR_

JOB, ORA_VCS_SUPPLY_CHAIN_
COLLABORATION_PLANNER_JOB,
ORA_WSH_SHIPPING_MANAGER_

JoB
/Shared/Functional Setup BI_FSM_REPORTING_DUTY Functional Setups Folder Reporting ORA_ASM_APPLICATION_
Duty *Not inherited by Custom B IMPLEMENTATION_CONSULTANT_
Web cat Reporting Duty JoB
/Shared/Security FBI_SECURITY_TRANSACTION_ Security Transaction Analysis Duty = ORA_FND_IT_SECURITY_
ANALYSIS_DUTY *Not inherited by Custom Bl Web MANAGER_JOB

cat Reporting Duty

Predefined Catalog Lockdown
If you try to modify the predefined catalog content including folder permissions, you get an alert indicating that you're
not allowed to modify content and asking that you save your own content in the /Shared/Custom folder.

Here are a few things to know about catalog folders:

- You must save all modified content in the /Shared/Custom folder or in new folders in the /Shared folder.

- Existing modified content in the /Shared/Custom folder or custom folders in the /Shared folder and their
subfolders is preserved. If you have modified the content in the predefined catalog folders, all changes are lost
during any upgrade. To preserve content, archive your catalog content and unarchive it in the Shared/Custom
folder after upgrade.

- All existing content in parent folders in the /Shared folder is preserved.

- You can't change folder or object permissions on the predefined catalog folders or content. For example, you
can't change folder permissions to hide folders or objects.

Related Topics
« Role Inheritance

- Archive and Move Analytics
« Submit Scheduled Processes and Process Sets
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Procurement Repository and Session Variables for
Business Intelligence

You can use these repository and session variables in your analyses:

Variable Name Type Usage Offering
CURRENT_DAY Session Variable Returns the value of Current Date. = All
CURRENT_MONTH Repository Variable Returns the value of Current Month  All

in the YYYY/MM format.
CURRENT_WEEK Repository Variable Returns the value of the current All

week in YYYY Weeknnn format.

CURRENT_QUARTER Repository Variable Returns the value of Current All
Quarter in YYYY Q n format.

CURRENT_YEAR Repository Variable Returns the value of Current Year All
inthe YYYY format.

NEXT_MONTH Repository Variable Returns the value of Next Monthin Al
the YYYY / MM format.

NEXT_WEEK Repository Variable Returns the value of Next Week in Al

the YYYY Week nn format.

NEXT_QUARTER Repository Variable Returns the value of Next Calendar Al
Quarter in the YYYY Q nn format.

NEXT_YEAR Repository Variable Returns the value of Next Year in All
the YYYY format.
PREVIOUS_MONTH Repository Variable Returns the value of Previous All

Month in the YYYY/MM format.

PREVIOUS_WEEK Repository Variable Returns the value of Previous Week All
in the YYYY Week nn format.
PREVIOUS_QUARTER Repository Variable Returns the value of Previous All

Quarter in the YYYY Q nn format.

This variable is available for only Oracle Fusion Cloud Procurement:
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Variable Name Type

PO_ACK_FEATURE_INDICATOR Repository Variable

Usage

Returns Y or N to indicate whether
the customer has enabled

the opt-in to skip the supplier
acknowledgment phase.

Offering

Procurement

ORACLE

38



Oracle Fusion Cloud Procurement Chapter 3
Creating and Administering Analytics and Reports for Subject Areas
Procurement

5 Subject Areas

Procurement Subject Areas, Folders, and Attributes

To create real-time analyses, you should be familiar with the Oracle Business Intelligence concepts of subject areas,
folders, and attributes.

Subject Areas

To create an analysis, you begin by selecting a subject area and then select columns of information to include in the
analysis.

For a complete list of procurement-specific subject areas, see the Oracle Fusion Cloud Procurement: Subject Areas for
Transactional Business Intelligence in Procurement

Folders

Each subject area has one fact folder and a number of dimension folders. Fact folders contain attributes that can

be measured, meaning that they're numeric values like order quantity and order amount. A special folder, called a
Degenerate Dimension, is also associated with the fact folder. Each dimension folder is joined to the fact folder within a
subject area.

Some folders, such as Buyer, Procurement BU, and Requisitioning BU, appear in more than one subject area. These are
referred to as common folders or common dimensions. Fact folders are usually at the bottom of the list of folders and
named after the subject area.

Each fact has a different level of granularity. For example, Buyer has contact details.

Attributes

Finally, each dimension folder contains attributes, such as address, item details, and so on.

This figure illustrates the structure of subject areas, folders, and facts.
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Subject Areas 77}

B Address Line 2
B Address Line 3
B Address Line 4
8 City
B Country
B E-mail
B Full Name
B Manager Name
B Number
B Postal Code
> %, Purchase Buyer
» [ Carrier
»* [ Document Status
» [ Freight on Board
> [0 Freight Terms
> [ Payment Terms
» 23 Procurement BU
> [ Project Details
» [ Purchase Order Distributions
» [ Purchase Order Document Style
> [ Purchase Order Header
» [0 Purchase Order Header Detail
» [[) Purchase Order Lines
1 Purchase Order Schedules
» [ Additional Schedule Information
[ Purchase Order Schedule
[I Accepted Quantity
[ silled Amount
@ silled Quantity
3 Count i

m

In the preceding figure, the following OTBI components are shown:

- Subject area: Procurement - Purchasing Real Time

- Dimension presentation folder: Buyer

- Dimension attributes: Address Line 1, City, Country, Full Name. and so forth
- Fact presentation folder: Purchase Order Schedules

- Fact measures: Accepted Quantity, Billed Amount, Billed Quantity, Count

Related Topics

 Subject Areas for Transactional Business Intelligence in Procurement

ORACLE
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4 Flexfields

Overview of Flexfield Use in Analyses

Flexfields are extensible sets of placeholder fields associated with business objects that can be placed on application
pages. They're used to extend business objects and meet your data management requirements without changing the
data model or performing any database programming.

To include flexfields you have used for extension for use in analyses, you must enable them for business intelligence.

Extension of analyses using flexfields is available for Oracle Enterprise Resource Planning Cloud and Oracle Human
Capital Management Cloud.

Flexfield Types

The following types of flexfields are available and provide a means to modify application features without programming:

Descriptive
Extensible
Key

Depending on the flexfield type, business intelligence enablement is performed differently and has different
requirements. Once they are enabled for business intelligence, you can import any changes made to flexfields
automatically using an import scheduled process.

Configure Key Flexfields for Transactional Business
Intelligence

Enable Key Flexfields for Business Intelligence Reporting

To include flexfields in your analyses, you must enable them for Business Intelligence. Extensibility of analysis using
flexfields is used for Enterprise Resource Planning and Human Capital Management. For Customer Relationship
Management, the Extensibility Framework supports this.

To designate key flexfields as Bl-enabled:

In the Setup and Maintenance work area, go to the Manage Key Flexfields task.
On the Manage Key Flexfields page, enter your search value in Key Flexfield Code.
Click Manage Structure Instances.

Enter your search value in Structure Instance Code.

Click Edit to display the Edit Key Flexfield Structure Instance dialog box.

Select the Bl Enabled option, then click OK.

For each flexfield segment instance, repeat steps 5 through 6.

Click Save.

PONOUARWNA
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9. Populate the Bl Object Name for each of the segment labels:

a. Query the Key Flexfield Code in the Manage Key Flexfields window.
From the Actions menu, select Manage Segment Labels.

c. Populate the Bl Object Name for each segment label to be mapped. The Bl Object Name for the following
qualified segment labels should not be modified:

Segment Label Code Bl Object Name

FA_COST_CTR Dim - Cost Center
GL_BALANCING Dim - Balancing Segment
GL_ACCOUNT Dim - Natural Account Segment

Before you deploy a flexfield, you must access the Chart of Accounts Instance and assign the newly
created segment label to the appropriate segment in the Chart of Accounts.

d. Click Deploy Flexfield.
e. Click Save and Close.

Related Topics
« Considerations for Enabling Key Flexfield Segments for Business Intelligence

» Update Existing Setup Data

Overview of Supported Key Flexfields

Key flexfields are used to store internally defined codes unique to a particular business, specifying part numbers,
general ledger accounts, and other business entities.

Product Area Key Flexfield Dimension

Fixed Assets Category (CAT#) Dim - Asset Category
Fixed Assets Location (LOC#) Dim - Asset Location
General Ledger Accounting (GL#) Dim - Balancing Segment

Dim - Cost Center

Dim - Natural Account

Payroll Costing Dim - Costing Segments

42
ORACLE


https://www.oracle.com/pls/topic/lookup?ctx=fa24a&id=s20035020
https://www.oracle.com/pls/topic/lookup?ctx=fa24a&id=s20051179

Oracle Fusion Cloud Procurement Chapter 4

Creating and Administering Analytics and Reports for Flexfields
Procurement

Product Area Key Flexfield Dimension

Supply Chain Management Locator Dim - Inventory Org

Supply Chain Management Item Category Dim - Item

Revenue Management Pricing Dimensions (VRM) Dim - VRM Segment

Budgetary Control Budgeting (XCC) Dim - XCC Segment

Map Non-Qualified Segments to Bl Objects

To map non-qualified segments that must be mapped and used in analysis, create a new label and associate a Bl object
with the label. Associate this new segment label with the segment code.

To map non-qualified segments to Bl objects:

In the Setup and Maintenance work area, go to the Manage Key Flexfields task.

On the Manage Key Flexfields page, search for the appropriate key flexfield code.

From the Actions menu, select Manage Segment Labels.

Click the Add Row icon.

Enter the details for the Segment Label Code, including name, description, and Bl Object name. Enter the BI
object names carefully and note whether there is a space between Segment and the number.

VuhWNRA

This table provides examples of Key Flexfields and associated Bl object names.

Key Flexfield Bl Object Name

Accounting (GL) Dim - GL Segment1 through Dim - GL Segment10
Budgetary Control (XCC) Dim - XCC Segment1 through Dim - XCC Segment10
Revenue Management (VRM) Dim - VRM Segment 1through Dim - VRM Segment 10

6. Complete the mapping by assigning unique segment labels to the key flexfields.

Set Up the GL Accounting Flexfields

This topic describes the workflow for setting up Accounting key flexfields, but these steps also apply for other key
flexfields.

- Understanding Accounting Key Flexfields
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- Identifying Accounting Key Flexfields

- Assigning Unique Segment Labels

- Performing Column Flattening

- Designating GL Accounting Segment Instances as Bl-Enabled

- Deploying Accounting Key Flexfields

Understanding Accounting Key Flexfields

The Accounting Key Flexfield is used to identify GL accounts.

A chart of accounts segment is a component of the accounting key flexfield. Each segment has a value set attached

to it to provide formatting and validation of the set of values used with that segment. The combination of segments
creates the account combination used for recording and analyzing financial transactions. You must set up your Chart of
Accounts (COA) as part of implementing Oracle Applications Cloud.

Examples of segments that may be found in a chart of accounts structure include Company, Cost Center, Department,
Division, Region, Account, Product, Program, and Location.

The Natural Account segment of the General Ledger Accounting Key Flexfield defines the account used in the account
combination to record transactions.

The logical segment dimensions in the Oracle Bl metadata are pim - cost Center,Dim - Balancing Segment, Dim -
Natural Account Segment and all pim - GL Segmentndimensions. These dimension tables are populated from a Tree
value object or from a Value Set value object. Which value is used depends on whether a tree was associated with the
segment in the Oracle Applications Cloud setup:

- For each segment associated with trees, two value objects are generated (Tree and TreeCode) with the following
naming structure:

FscmTopModelAM.AccountBIAM.FLEX TREE VS_segmentlabel VI &

FscmTopModelAM.AccountBIAM. FLEX TREECODE VS_segmentlabel VI

- For each segment without trees, one view object is generated with the following naming structure:
FscmTopModelAM.AccountBIAM.FLEX VS _ XXX VI

In addition to the segment dimension tables, the Bl Extension process also extends Flex BI Flattened Vo;
FscmTopMode1AM.AccountBIAM. FLEX BI_Account_VI. This view object has a pair of columns for each segment;
segmentlabel_ and segmentlabel_c.

For example, for your Cost Center segment which has the segment label FA_COST_CTR, there are two columns in this
view object, named FA_COST_CTR_and FA_COST_CTR_c.

ldentifying Accounting Key Flexfield Segments
Identify and map segments of the chart of accounts.
For each Chart of Accounts (Accounting Key Flexfield) used to analyze Transactional Business Intelligence facts, identify

the segments of the chart of accounts. Map them to the Transactional Business Intelligence GL Accounting Segment
logical dimensions.

44
ORACLE



Oracle Fusion Cloud Procurement Chapter 4

Creating and Administering Analytics and Reports for Flexfields
Procurement
Accounting Key Flexfield Segment Segment Label Transactional Business Intelligence GL

Accounting Segment Logical Dimension

Balancing GL_BALANCING Dim - Balancing Segment

Natural Account GL_ACCOUNT Dim - Natural Account Segment

Cost Center FA_COST_CTR Dim - Cost Center

Other segments to be equalized across the Other unique segment label Dim - GL Segment n where n is an integer from
charts of accounts 1to 10

Assigning Unique Segment Labels

You must assign a unique segment label to the charts of accounts segments that are the balancing segments or the
natural account segments. The segments must be also used for specific purposes.

For example, assign the Primary Balancing segment label to the segment used for your company or legal entities. That
label provides a correct recording of intercompany transactions and company analysis. You can assign other segment
labels when required.

To assign unique segment labels to charts of accounts segments:

1.

10.
n.

In the Setup and Maintenance work area, go to the Manage Charts of Accounts task and then navigate to the
Manage Chart of Accounts page.

In the Search section, enter the GL# for the Key Flexfield Code and click the Search button.

In the Search Results section, select Accounting Flexfield and click the Manage Structures button to navigate
to Manage Key Flexfield Structures.

In the Search section, enter the chart of accounts code or the name for Structure Code or Name and click the
Search button.

In the Search Results section, select the chart of accounts and click Edit to navigate to the Edit Key Flexfield
Structure window

Select the Enabled check box to code-enable the Structure code.

In the Segments section, select the applicable segments and click Edit to navigate to the Edit Key Flexfield
Segment window.

Select the Enabled check box to enable the segments.

In the Segment Labels section, select the unique segment labels to equalize the segments across the charts of
accounts. Click theshuttle to move the segments to the selected list.

Click Save and Close to return to the Edit Key Flexfield Structure window.

Click Done to return to the Manage Key Flexfields window.

Performing Column Flattening

Column flattening of trees is required in order for OTBI hierarchy analyses to be populated with correct data.

To flatten columns for account hierarchies:

1.

2.

In the Setup and Maintenance work area, go to the Manage Trees and Tree Versions task and navigate to the
Manage Trees and Tree Versions window.

In the Search section, enter GL_ACCT_FLEX for the Tree Structure Code and the involved tree code or name,
and click Search.

45

ORACLE



Oracle Fusion Cloud Procurement Chapter 4

Creating and Administering Analytics and Reports for Flexfields
Procurement

3. Inthe Search Results section, select the tree version you want to flatten. If the status of the Tree Version is
Draft, to make the Tree Version active, select Actions, then Status, and then Active.

4. (Optional): After the tree version is specified, perform an audit on the Tree Version to ensure its integrity before
launching the flattening job. Select Actions and then Audit. See the section on working with Trees in the
Developer's Guide.

5. Choose Column Flattening from the Actions menu.

6. Click the Online Flattening button to launch the flattening job immediately. Or, click the Schedule Flattening

button to schedule the flattening job according to your requirements.

Designating GL Accounting Segment Instances as Bl-Enabled

Specify the applicable chart of accounts segment instances that are Bl-enabled to make them available for use in
Transactional Business Intelligence.

To specify the chart of accounts segment instances as Bl-enabled:

1.

N
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9.
10.

In the Search Results section of the Manage Key Flexfields window, select Accounting Flexfield and click the
Manage Structure Instances button to navigate to the Manage Key Flexfield Structure Instances window.

In the Search section, select the chart of accounts for Structure Name and click the Search button.

In the Search Results section, select the structure instance and click Edit to navigate to the Edit Key Flexfield
Structure Instance window.

Check the Enabled check box to code-enable the structure instance.

In the Segment Instances section, select the segment instances and click Edit to update. Each of the segment
instances must be selected individually.

Select the Business Intelligence enabled check box in the Edit Key Flexfield Segment pop-up window and click
OK to return to Edit Key Flexfield Structure Instance window.

After you have enabled all applicable segment instances for Business Intelligence, click Save and Close to save
the changes and return to the Edit Key Flexfield Structure Instance window.

Repeat steps 2 - 6 for each chart of accounts to enable all the applicable segment instances for Business
Intelligence.

Click Done to return to the Manage Key Flexfields window.

After you have configured all the charts of accounts, click the Deploy Flexfield button to deploy the
Accounting Flexfield and make the latest definition available for use.

Deploying Accounting Key Flexfields

After you have set up accounting key flexfields, you must deploy them.

Accounting key flexfields have one of the following deployment statuses:

Edited: The flexfield definition has not been deployed or changes have been made to the structure, the
structure instances, or the value sets.

Patched: The flexfield definition has been modified through an update, but the flexfield has not yet been
deployed so the updated definition is not reflected.

Deployed to Sandbox: The flexfield is deployed and available in a flexfield-enabled sandbox.
Deployed: The flexfield definition is deployed and available to end users.

Error: The deployment attempt failed.

To deploy accounting key flexfields:

1.
2.
3.

In the Setup and Maintenance work area, go to the Manage Chart of Accounts task.
Click Search.
Locate the Deployment Status column.
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4. Click theicon.
Select Edited.
Click Deploy Flexfield.
Monitor the Deployment Status and when it reaches 100% click OK.
Verify that a check mark displays in the Deployment Status column.
Click Done.

S A 4

Configure Descriptive Flexfields for Transactional
Business Intelligence

Overview of Transactional Business Intelligence Configuration of
Descriptive Flexfields

Configure descriptive flexfields to track unique information not typically found on business forms.

Descriptive flexfields can store several important details on a form without cluttering it. For example, several details may
make an asset form heavy and unmanageable. However, the user still needs to access those details and therefore, they
must be present on the form. In such cases, descriptive flexfields are convenient to use and are easy to manage.

Descriptive flexfields provide a way for you to add attributes to entities and to define validation and display properties
for them. A descriptive flexfield is a logical grouping of attributes (segments) that are mapped to a set of extension
columns which are shipped as part of Oracle Applications Cloud tables.

Related Topics
« Configure Descriptive Flexfield Segments

« Set Descriptive Flexfields as Bl-Enabled

Configure Descriptive Flexfield Segments

If a descriptive flexfield is enabled for Oracle Business Intelligence, you can enable global and context segments for
Oracle Business Intelligence, and you can select segment labels. Not all descriptive flexfields are supported for Business
Intelligence.

Configuring a Descriptive Flexfield Segment

If a descriptive flexfield is enabled for Oracle Business Intelligence, you can enable global and context segments for
Oracle Business Intelligence, and you can select segment labels. Not all descriptive flexfields are supported for Business
Intelligence.

To configure available descriptive flexfield segments:

1. In the Setup and Maintenance work area, go to the Manage Descriptive Flexfields task.
2. If the Bl Enabled option is cleared, select it.
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3. Select the options for deployment of the descriptive flexfields.

Related Topics

Set Descriptive Flexfields as Bl-Enabled

If a descriptive flexfield is already defined, you can enable it for use in Business Intelligence reports. Not all descriptive
flexfields are supported for Business Intelligence.

Setting a Flexfield as Bl-Enabled

In the Setup and Maintenance work area, go to the Manage Descriptive Flexfields task.

Navigate to the Edit Descriptive Flexfields window.

Enter the descriptive flexfield name.

Check the Bl Enabled option on the desired descriptive flexfields. If the option is unavailable, the flexfield is a
non-supported entity.

Click OK.

Click Save.

PWNA
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Import Changes to Flexfields Automatically

Overview of Flexfield Change Import

You can use the Import Oracle Fusion Data Extensions for Transactional Business Intelligence scheduled process to
import your flexfield changes.

Use the Import Oracle Fusion Data Extensions for Transactional Business Intelligence scheduled process to
automatically import the following types of changes:

Key Flexfield changes
Descriptive Flexfield changes
Extensible Flexfield changes

The Import Oracle Fusion Data Extensions for Transactional Business Intelligence scheduled process imports extensible
data, including data in descriptive flexfield segments, key flexfield segments, and General Ledger balances in Essbase
cubes.

If you have changes to key flexfields and descriptive flexfields, you can import all the changes in the same scheduled
process.

This is an Oracle Applications Cloud scheduled process; it's not related to Bl Applications. Detailed information on this
process can be found in Oracle Applications Cloud documentation.

Note: We strongly recommend that you backup the Oracle Transactional Business Intelligence prior to importing any
flexfield changes. Running the process disconnects all users from the server. You should not run this process when
maintenance operations or system updates are being performed on the server.

48
ORACLE



Oracle Fusion Cloud Procurement Chapter 4
Creating and Administering Analytics and Reports for Flexfields
Procurement

Performance and Flexfields
Flexfield changes and additions increase the size of the metadata repository and over time can cause performance
issues or the repository size to exceed limitations. We recommend that you import and enable for Bl only those
flexfields that are required. To preserve performance, the following guidelines should be kept in mind:

Don't Bl-enable extensible flexfield (EFF) attributes that aren't needed for analysis in OTBI.

Disable EFF attributes that are no longer being used. Limit the number of attributes that are inherited by a large
number of classes to be Bl enabled, as this results in increased repository size.

Run the Import Scheduled Process

To import changes, run the Import Oracle Fusion Data Extensions for Transactional Business Intelligence scheduled
process.

Run the Job

To run the process:

In the Scheduled Processes window, select Search and Select: Name.

Select Search and Select: Name.

Highlight Import Oracle Fusion Data Extensions for Transactional Business Intelligence.
Click OK.

Schedule the process.

VAWNA

Process Status Conditions
When the process is finished, the biExtenderCMDUgtility.jar writes the status of the process into the JNDI file
ess_biExtenderEssJob_jobStatus, which can be viewed in Oracle WebLogic Server.

The process status displays one of the following conditions:

INIT: The process has just begun and is waiting for the extender command line JAR to update the status with
more details.

- COMPLETED_NO_EXTENSION_NEEDED: No new Flexfield changes were detected in any of the Oracle
Applications Cloud sources; because the Oracle Business Intelligence is already synchronized with all Flexfield
changes, no changes were made in the Oracle Business Intelligence.

- COMPLETED: Oracle Business Intelligence was successfully updated with Flexfield changes and uploaded into
the Oracle Business Intelligence Server.

- COMPLETED: PROCESS_ERRORS: Oracle Business Intelligence was updated with the Flexfield changes but with
some warnings that require manual intervention.

FAILED: Error conditions exist that require manual intervention.
Successful Import Process
If the import process is successful, you can perform the following actions:

- Query subject areas by segment dimensions such as Balancing Segment and Cost Center.
- Access DFF attributes for analyses.
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- Use the General Ledger - Balances Real Time subject area to query Oracle Essbase cubes.

Disable Flexfields as Bl-Enabled

Overview

If you created a flexfield that you no longer want to use or report against, you can disable the flexfield as Bl-enabled.

There may be times, such as during development phases, when you try using a flexfield and later determine it is no
longer needed.

Note: If you are considering disabling flexfields, keep in mind that any flexfields created in Oracle Applications Cloud
must be designated as Bl-enabled to be exposed in Transactional Business Intelligence. If you disable a flexfield, it
cannot be deployed. Also, error conditions may occur if you disable a descriptive flexfield that has been implemented
in Bl Applications. If error conditions arise from disabling flexfields as Bl-enabled, troubleshooting the errors can be
difficult and time-consuming.

Related Topics
« Disable Key Flexfields as Bl-Enabled

« Disable Descriptive Flexfields as Bl-Enabled
- Disable Extensible Flexfields as Bl-Enabled

Disable Key Flexfields as Bl-Enabled

If you created a flexfield that you no longer want to use or report against, you can disable the flexfield as Bl-enabled.

If you are considering disabling key flexfields, keep in mind that any flexfields created in Oracle Applications Cloud must
be designated as Bl-enabled to be exposed in Transactional Business Intelligence.

Disabling Key Flexfields
To disable key flexfields as Bl-enabled:

In the Setup and Maintenance work area, go to the Manage Key Flexfields task.
Enter your search value in Key Flexfield Code.

Click Manage Structure Instances.

Enter your search value in Structure Instance Code.

Click Edit. The Edit Key Flexfield Structure Instance dialog box displays.

In Edit Key Flexfield Segment Instance, deselect the Bl Enabled option.

Click OK, then Save.

NoUuhAUWUNRA

50
ORACLE


https://www.oracle.com/pls/topic/lookup?ctx=fa24a&id=s20056879

Chapter 4
Flexfields

Oracle Fusion Cloud Procurement
Creating and Administering Analytics and Reports for
Procurement

Disable Descriptive Flexfields as Bl-Enabled

If you created a flexfield that you no longer want to use or report against, you can disable the flexfield as Bl-enabled.

If you are considering disabling descriptive flexfields, keep in mind that any flexfields created in Oracle Applications
Cloud must be designated as Bl-enabled to be exposed in Transactional Business Intelligence.

Disabling Descriptive Flexfields

To disable descriptive flexfields as Bl-enabled:

PUWNA

In the Setup and Maintenance work area, go to the Manage Descriptive Flexfields task.
Enter the Descriptive Flexfield Name.
Deselect the Bl Enabled option on the desired descriptive flexfields.
Click OK, then Save.

Procurement Descriptive Flexfields for Business

Intelligence

This table shows the descriptive flexfields supported in Oracle Fusion Cloud Procurement and Oracle Self Service
Procurement along with the applicable subject areas, folders, parent folders, and logical dimensions.

Descriptive Flexfield Code

HZ_PARTY_SITES

HZ_PERSON_PROFILES

POR_REQ_DISTRIBUTIONS

POR_REQUISITION_

HEADERS

POR_REQUISITION_LINES

PO_DISTRIBUTIONS

ORACLE

Subject Area

Supplier Import - Supplier
Real Time

Supplier Import - Supplier
Real Time

Procurement - Requisitions
Real Time

Procurement - Requisitions
Real Time

Procurement - Requisitions
Real Time

Procurement - Purchasing
Real Time

Folder

Standard Address Level
DFFs

Standard Contact Level
DFFs

Requisition Distribution
Detail

Requisition Header Detail

Requisition Line Detail

Purchase Order Distribution
Detail

Parent Folder

Supplier Addresses

Supplier Contacts

Requisition Distribution

N/A

Requisition Line

Purchase Order
Distributions

Logical Dimension

Dim - Supplier Addresses

Dim - Supplier Contacts

Dim - Purchase Requisition
Details

Dim - Purchase Requisition
Details

Dim - Purchase Requisition
Details

Dim - Purchase Order
Details

51



Oracle Fusion Cloud Procurement
Creating and Administering Analytics and Reports for

Procurement

Descriptive Flexfield Code Subject Area

PO_DISTRIBUTIONS

PO_HEADERS

PO_HEADERS

PO_HEADERS

PO_HEADERS

PO_HEADERS

PO_HEADERS

PO_LINES

PO_LINES

PO_LINES

PO_LINES

PO_LINE_LOCATIONS

PO_LINE_LOCATIONS

PO_LINE_LOCATIONS

ORACLE

Procurement - Pending
Change Orders Real Time

Procurement - Purchasing
Real Time

Procurement - Purchasing
Agreements Real Time

Procurement - Purchasing
Agreements Real Time

Procurement - Pending
Change Orders Real Time

Procurement - Pending
Change Orders Real Time

Procurement - Pending
Change Orders Real Time

Procurement - Purchasing
Real Time

Procurement - Purchasing
Agreements Real Time

Procurement - Pending
Change Orders Real Time

Procurement - Pending
Change Orders Real Time

Procurement - Purchasing
Real Time

Procurement - Purchasing
Agreements Real Time

Procurement - Pending
Change Orders Real Time

Folder

Purchase Order Pending
Change Order Distribution
Detail

Purchase Order Header
Detail

Blanket Agreement Header
Detail

Contract Agreement Detail

Purchase Order Pending
Change Order Header
Detail

Blanket Agreement
Pending Change Order
Header Detail

Contract Agreement
Pending Change Order
Detail

Purchase Order Line Detail

Blanket Agreement Line
Detail

Purchase Order Pending
Change Order Line Detail

Blanket Agreement
Pending Change Order Line
Detail

Purchase Order Schedule
Detail

Blanket Agreement Price
Break Detail

Purchase Order Pending
Change Order Schedule
Detail

Parent Folder

Pending Change
Distributions

N/A

N/A

N/A

N/A

N/A

N/A

Purchase Order Lines

Blanket Agreement Lines

Pending Change Order
Lines

Pending Change Order
Lines

Purchase Order Schedules

Blanket Agreement Price

Breaks

Pending Change Schedules

Chapter 4
Flexfields

Logical Dimension

Dim - Draft Purchase Order
Details

Dim - Purchase Order
Details

Dim - Purchase Agreement
Details

Dim - Purchase Agreement
Details

Dim - Draft Purchase Order
Details

Dim - Draft Purchase Order
Details

Dim - Draft Purchase Order
Details

Dim - Purchase Order
Details

Dim - Purchase Agreement
Details

Dim - Draft Purchase Order
Details

Dim - Draft Purchase Order
Details

Dim - Purchase Order
Details

Dim - Purchase Agreement
Details

Dim - Draft Purchase Order
Details
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Descriptive Flexfield Code Subject Area

PO_LINE_LOCATIONS

PO_NOTIFICATION_

CONTROLS

PO_ATTRIBUTE_VALUES

PO_LINE_TYPES

PO_LINE_TYPES

PO_LINE_TYPES

PO_LINE_TYPES

PO_LINE_TYPES

PO_LINE_TYPES

PO_LINE_TYPES

PON_AUCTION_HEADERS

PON_AUCTION_ITEM_

PRICES

PON_PROGRAM_HEADERS

POQ_ASSESSMENTS

POQ_INITIATIVES

ORACLE

Procurement - Pending
Change Orders Real Time

Procurement - Purchasing
Agreements Real Time

Procurement - Purchasing
Agreements Real Time

Procurement - Pending
Change Orders Real Time

Procurement - Purchasing
Agreements Real Time

Procurement - Purchasing
Real Time

Procurement - Requisitions
Real Time

Sourcing - Supplier Awards
Real Time

Sourcing - Supplier
Negotiations Real Time

Sourcing - Supplier
Responses Real Time

Sourcing - Supplier
Negotiations Real Time

Sourcing - Supplier
Negotiations Real Time

Sourcing - Program Real
Time

Supplier Qualification
- Quialifications and
Assessments Real Time

Supplier Qualification
- Qualifications and
Assessments Real Time

Folder

Blanket Agreement
Pending Change Order
Price Break Detail

Contract Agreement
Notification Controls

Blanket Agreement Item

Attributes

Purchasing Line Type

Purchasing Line Type

Purchasing Line Type

Purchasing Line Type

Purchasing Line Type

Purchasing Line Type

Purchasing Line Type

Negotiation Header Detail

Negotiation Line Detail

Program Detail

Assessment Detail

Initiative Detail

Parent Folder

Pending Change Schedules

N/A

Blanket Agreement Lines

Pending Change Order

Lines

Blanket Agreement Lines

Purchase Order Lines

Requisition Line

N/A

Negotiation Line

Response Line

Negotiation Header

Negotiation Line

N/A

Assessments

N/A

Chapter 4
Flexfields

Logical Dimension

Dim - Draft Purchase Order
Details

Dim - Agreement

Notification Controls

Dim - Purchase Agreement

Details

Dim - Purchase Line Type

Dim - Purchase Line Type

Dim - Purchase Line Type

Dim - Purchase Line Type

Dim - Purchase Line Type

Dim - Purchase Line Type

Dim - Purchase Line Type

Dim - Sourcing Negotiation

Details

Dim - Sourcing Negotiation
Details

Dim - Sourcing Program
Details

Dim - Assessment Details

Dim - Initiative Details
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Descriptive Flexfield Code

POQ_QUALIFICATIONS

Subject Area

Supplier Qualification
- Qualifications and
Assessments Real Time

Folder

Quialification Detail

Parent Folder

Quialifications

Logical Dimension

Dim - Quialification Details

POZ_SUPPLIERS (sameas = Procurement - Supplier Profile N/A Dim - Supplier
JE_POZ_SUPPLIERS) Implemented Change

Orders Real Time
POZ_SUPPLIERS (same as = Procurement - Pending Supplier Profile N/A Dim - Supplier
JE_POZ_SUPPLIERS) Change Orders Real Time
POZ_SUPPLIERS (same as = Procurement - Procure To Supplier N/A Dim - Supplier
JE_POZ_SUPPLIERS) Pay Real Time
POZ_SUPPLIERS (same as = Procurement - Spend Real = Supplier Profile N/A Dim - Supplier
JE_POZ_SUPPLIERS) Time
POZ_SUPPLIERS (same as = Procurement - Purchasing = Supplier Profile N/A Dim - Supplier
JE_POZ_SUPPLIERS) Agreements Real Time
POZ_SUPPLIERS (same as = Procurement - Purchasing = Supplier Profile N/A Dim - Supplier
JE_POZ_SUPPLIERS) Real Time
POZ_SUPPLIERS (same as = Procurement - Requisitions  Suggested Supplier Requisition Line Dim - Supplier
JE_POZ_SUPPLIERS) Real Time
POZ_SUPPLIERS (same as = Sourcing - Supplier Awards = Supplier Profile N/A Dim - Supplier
JE_POZ_SUPPLIERS) Real Time
POZ_SUPPLIERS (same as = Sourcing - Supplier Supplier Profile Response Line Dim - Supplier
JE_POZ_SUPPLIERS) Responses Real Time
POZ_SUPPLIERS (same as = Supplier - Supplier Real Supplier Profile N/A Dim - Supplier
JE_POZ_SUPPLIERS) Time
POZ_SUPPLIERS (same as = Supplier Import - Supplier = Supplier Profile Suppliers Dim - Supplier
JE_POZ_SUPPLIERS) Real Time
POZ_SUPPLIERS (same as = Supplier Registration - Supplier Profile Suppliers Dim - Supplier
JE_POZ_SUPPLIERS) Supplier Registration Real

Time
POZ_SUPPLIERS (same as = Supplier Qualification - Supplier Profile N/A Dim - Supplier
JE_POZ_SUPPLIERS) Question Responses Real

Time
POZ_SUPPLIERS (same as = Payables Invoices - Holds Supplier N/A Dim - Supplier

JE_POZ_SUPPLIERS)

ORACLE

Real Time
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Descriptive Flexfield Code

POZ_SUPPLIERS (same as
JE_POZ_SUPPLIERS)

POZ_SUPPLIERS (same as
JE_POZ_SUPPLIERS)

POZ_SUPPLIERS (same as
JE_POZ_SUPPLIERS)

POZ_SUPPLIERS (same as
JE_POZ_SUPPLIERS)

POZ_SUPPLIERS (same as
JE_POZ_SUPPLIERS)

POZ_SUPPLIERS (same as
JE_POZ_SUPPLIERS)

POZ_SUPPLIERS (same as
JE_POZ_SUPPLIERS)

POZ_SUPPLIERS (same as
JE_POZ_SUPPLIERS)

POZ_SUPPLIER_
REGISTRATIONS

POZ_SUPPLIER_SITES_
ALL_M (same as JE_POZ_
SUPPLIER_SITES)

POZ_SUPPLIER_SITES_
ALL_M (same as JE_POZ_
SUPPLIER_SITES)

POZ_SUPPLIER_SITES_
ALL_M (same as JE_POZ_
SUPPLIER_SITES)

POZ_SUPPLIER_SITES_
ALL_M (same as JE_POZ_
SUPPLIER_SITES)

POZ_SUPPLIER_SITES_
ALL_M (same as JE_POZ_
SUPPLIER_SITES)

ORACLE

Subject Area

Payables Invoices -
Installments Real Time

Payables Invoices -
Prepayment Applications
Real Time

Payables Invoices -
Transactions Real Time

Payables Invoices - Trial
Balance Real Time

Payables Invoices -
Withholding Real Time

Payables Payments -
Disbursements Real Time

Payables Payments -
Payment History Real Time

Subledger Accounting -
Journals Real Time

Supplier Registration -
Supplier Registration Real
Time

Procurement -
Implemented Change
Orders Real Time

Procurement - Pending
Change Orders Real Time

Procurement - Spend Real
Time

Procurement - Purchasing
Agreements Real Time

Procurement - Purchasing
Real Time

Folder

Supplier

Supplier

Supplier

Supplier

Supplier

Supplier

Supplier

Supplier Profile

Company Details

Supplier Site

Supplier Site

Supplier Site

Supplier Site

Supplier Site

Parent Folder

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A
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Logical Dimension

Dim - Supplier

Dim - Supplier

Dim - Supplier

Dim - Supplier

Dim - Supplier

Dim - Supplier

Dim - Supplier

Dim - Supplier

Dim - Supplier Registration

Request Details

Dim - Supplier Sites

Dim - Supplier Sites

Dim - Supplier Sites

Dim - Supplier Sites

Dim - Supplier Sites
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Descriptive Flexfield Code Subject Area

POZ_SUPPLIER_SITES_
ALL_M (same as JE_POZ_
SUPPLIER_SITES)

POZ_SUPPLIER_SITES_
ALL_M (same as JE_POZ_
SUPPLIER_SITES)

POZ_SUPPLIER_SITES_
ALL_M (same as JE_POZ_
SUPPLIER_SITES)

POZ_SUPPLIER_SITES_
ALL_M (same as JE_POZ_
SUPPLIER_SITES)

POZ_SUPPLIER_SITES_
ALL_M (same as JE_POZ_
SUPPLIER_SITES)

POZ_SUPPLIER_SITES_
ALL_M (same as JE_POZ_
SUPPLIER_SITES)

POZ_SUPPLIER_SITES_
ALL_M (same as JE_POZ_
SUPPLIER_SITES)

POZ_SUPPLIER_SITES_
ALL_M (same as JE_POZ_
SUPPLIER_SITES)

POZ_SUPPLIER_SITES_
ALL_M (same as JE_POZ_
SUPPLIER_SITES)

POZ_SUPPLIER_SITES_
ALL_M (same as JE_POZ_
SUPPLIER_SITES)

POZ_SUPPLIER_SITES_
ALL_M (same as JE_POZ_
SUPPLIER_SITES)

POZ_SUPPLIER_SITES_
ALL_M (same as JE_POZ_
SUPPLIER_SITES)

ORACLE

Procurement - Requisitions
Real Time

Sourcing - Supplier Awards
Real Time

Sourcing - Supplier
Responses Real Time

Sourcing - Supplier
Negotiations Real Time

Supplier - Supplier Real
Time

Supplier Import - Supplier
Real Time

Supplier Qualification -
Question Responses Real
Time

Payables Invoices - Holds
Real Time

Payables Invoices -
Installments Real Time

Payables Invoices -
Prepayment Applications
Real Time

Payables Invoices -
Transactions Real Time

Payables Invoices - Trial
Balance Real Time

Folder

Suggested Supplier Site

Response Supplier Site

Supplier Site

Invited Supplier Site

Supplier Site Details

Site Details

Supplier Site

Supplier Site

Supplier Site

Supplier Site

Supplier Site

Supplier Site

Parent Folder

Requisition Line

N/A

Response Line

Invited Suppliers

Supplier Sites

Supplier Sites

N/A

N/A

N/A

N/A

N/A

N/A

Chapter 4
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Logical Dimension

Dim - Supplier Sites

Dim - Supplier Sites

Dim - Supplier Sites

Dim - Supplier Sites

Dim - Supplier Sites

Dim - Supplier Sites

Dim - Supplier Sites

Dim - Supplier Sites

Dim - Supplier Sites

Dim - Supplier Sites

Dim - Supplier Sites

Dim - Supplier Sites
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Descriptive Flexfield Code Subject Area Folder

POZ_SUPPLIER_SITES_
ALL_M (same as JE_POZ_
SUPPLIER_SITES)

POZ_SUPPLIER_SITES_
ALL_M (same as JE_POZ_
SUPPLIER_SITES)

ORACLE

Payables Payments - Supplier Site
Disbursements Real Time

Payables Payments - Supplier Site
Payment History Real Time

Parent Folder

N/A

N/A

Chapter 4
Flexfields

Logical Dimension

Dim - Supplier Sites

Dim - Supplier Sites
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5 Analytics, Reports, and Dashboards
Modification

Analyses and Dashboards

How Data Is Structured for Analytics

The business intelligence (BI) repository contains the metadata that defines which columns you can include in analyses,
and the source of that data. The repository is organized into subject areas, which contain folders with the columns.

I Note: You can also use the Bl repository as a data source for reports.

Columns
This table describes the three types of columns available when you create or edit analyses.

Column Type Description Example

Fact Provides a measure of something, meaning Total
that the values are numbers.

Attribute Represents a piece of information about a Start Date
business object, with values that are dates, IDs,
or text.

Note:
Attribute columns can be flexfield segments
imported into the Bl repository.

Hierarchy Holds data values that are organized in a Time, with sublevels:
hierarchical manner.
Year
Quarter
Month

Subject Areas

When you create an analysis, you first select a subject area, which contains columns related to a specific business object
or area. Then, open folders within the subject area to find the columns to include.

59
ORACLE



Oracle Fusion Cloud Procurement Chapter 5
Creating and Administering Analytics and Reports for Analytics, Reports, and Dashboards Modification
Procurement

For product families that use Application Composer, you can create custom subject areas to accommodate custom
objects or to add new facts for analysis.

Folders
Each subject area has one fact folder and a number of dimension folders. Folders can have subfolders.

Fact folders:

o Contain fact columns.

o Are usually the last in a list of folders and are usually named after the subject area.
Dimension folders:

o Contain attribute and hierarchical columns.

o Are joined to the fact folder within a subject area.

For example, if your analysis has the Currency attribute from a dimension folder, you see currencies in
the results. If you also add the Total fact, then your analysis includes only records with both a currency
and a total amount. The more columns you add, the smaller the query set for your analysis.

o Can be common folders, or common dimensions, that appear in more than one subject area.
If your analysis has columns from multiple subject areas, then you:

- Should include columns only from dimension folders that are common to all of those subject areas.
At least one such column is required.

- Must include one column from the fact folder in each of those subject areas.

Related Topics
- Create and Edit Analyses Using a Wizard

+ Create and Modify Analyses and Dashboards
- Manage Analytics with Advanced Features
» About Custom Subject Areas

Create and Edit Analyses Using a Wizard

Use the wizards to quickly create and edit your analyses. You can use a wizard to create and edit most of your analytics,
for example to select columns, add filters or views.
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You can also use advanced business intelligence features to create or edit dashboards or manage analyses and other
objects in the catalog.

1. Start the wizard from the Reports and Analytics work area or the Reports and Analytics panel tab (if available).

o To create a new analysis click Create and select Analysis. Select a subject area for your analysis and click
theContinue button.

o To edit an existing analysis, in the Reports and Analytics work area, select it in a folder or the favorites list,
click its ellipsis icon and select Edit. In the Reports and Analytics panel tab, click the analysis, then click
Edit.

2. Inthe Select Columns page, optionally, click Add/Remove Subject Areas and, in the Add/Remove Subject
Areas dialog box, select more subject areas or remove any that you no longer need, and click OK. You can't
remove the original subject area selected for the analysis. To remove any other subject area, first remove its
columns from the analysis.

3. From here on, make selections in a series of analysis-definition pages, selecting Next or Back to navigate
among them.

o Inthe Select Columns page, expand your subject area and folders within it to choose the columns to
include in your analysis. Also set options for those columns.

o Inthe Select Views page, determine whether your analysis is to include a table, a graph, or both. For
either, select among several types. If you include both, select the order in which they appear.

o In Edit Table and Edit Graph pages, select options that apply to your table and graph layouts. Each of
these pages is active only if you selected the item it applies to in the Select Views page.

o Inthe Sort and Filter page, optionally apply filters to columns to refine the selection of records in your
analysis, and apply sorts to them to order your results.

o Inthe Highlight page, optionally add color highlights based on numeric thresholds you set.

o Inthe Save page, enter a name for the analysis, select a catalog folder to save it in, and click Submit.

In general, these pages are designed so that procedures for using them are readily apparent. Even so, here are some
things you will want to know.

Select Columns Page
For each column in your analysis, you select an Interaction option.

- Two of the options, Default and Drill, do the same thing: If you click on a column header, the analysis adds a
column displaying values at the next hierarchical level. (For example, if you click on Control Name, the analysis
adds a Control ID column.) If you click on a column value, the analysis adds the subordinate column, but also
filters to display only records containing the value you clicked.

Navigate to Transaction: If you click on a value from a column for which this option is set, the analysis presents
a link to the record of an object the value applies to.

For such links to work, however, further configuration is required: You need to define paths to the records

that are to be opened. If you want to use this option, you're probably better off creating the analysis in the BI
Catalog. However, you can create it in the wizard, then edit it in the Bl Catalog. See the topic titled Link Analyses
to Application Pages.

None: This option in effect turns the Default option off and turns nothing on. Nothing happens if you click on a
value in a column for which this option is set.

For each column, you can also select a Hidden option. This prevents the analysis from displaying the column, but leaves
its values available for use behind the scenes, for example in filters.
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Select Views Page

You can add a graph to your analysis only if it includes at least one column from a fact folder. (You can include a table
in your analysis no matter what columns you select for it.) A fact column contains numeric values, such as counts of
incidents returned by advanced controls. Other columns contain attributes of objects, such as names of advanced
controls. Without numeric values, there's nothing to base a graph on.

You can create a title for the analysis in this page, but doing so is optional. You also create a name for the analysis in the
Save page, and that one is required. If you create both, the analysis displays both; they don't have to be the same.

You can use a Preview option to ensure the analysis returns data you expect. Turn it on or off in this page or in
subsequent wizard pages. Once it's on, the preview remains on in other wizard pages you navigate to, unless you turn it
off.

Edit Table Page

Here are the layout options you can select for tables:

- Columns: This is the default. Each column you assign this value to appears as a column in the table.

Prompt For: In a prompt field, you select among values from the column you're configuring. For example, you
would select a date if the column were Calendar Month Start Date. The table would then display only rows
containing the value you selected.

- Section By: The table is divided into sections. Each value of the column you're configuring becomes a header,
and the section beneath each header includes rows containing that value.

Excluded: The column you select is no longer available to the view you're configuring. The column is hidden,
and its values are unavailable for behind-the-scenes tasks such as filtering. However, the column remains
available to other views in your analysis.

Edit Graph Page

You can't apply layout options to fact columns. For other columns, graph layout options include Prompt For, Section By,
and Excluded, which have the same effect as they do in tables. You can also apply these options in graphs:

- Vary Color By: Each value in the column you're configuring is represented by a distinct color in the graph.

- Group By: Values in the columns you assign this option to are combined in the graph. For example, if you select
this option for the State and Calendar Month Start Date columns in a bar graph, each bar represents a particular
status on a particular date.

Highlight Page

You can use this feature only if your analysis includes at least one fact column, and you can apply it only to fact
columns.

Related Topics
- View Analytics, Reports, and Dashboards

« Where to Save Analytics and Reports
« How Data Is Structured for Analytics
- Manage Analytics with Advanced Features
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Reports

Overview of Analytics Publisher

Oracle Analytics Publisher enables you to author, generate, and deliver all types of highly formatted documents and
operational reports.

You can use familiar office desktop tools to create rich text format (.rtf) documents and reports against any data source.
You can view reports, schedule them to run, and distribute them to predefined destinations.

Reports consist of one or more .rtf layouts, a reference to a data model, and a set of properties. A report may also
include style templates and subtemplates, which allow reusability of functionality and maintain consistency of design. In
the logical architecture depicted in the figure, the report includes a data model and a layout, and the layout references
two style templates in the catalog which in turn reference subtemplates.

In the Analytics Publisher logical architecture, the data model accesses data sources and the layout
and its optional style template and subtemplates determine the formatting of the report output,
which can include email, print, fax, or files, and others. The layout is designed using common office
applications, for example Microsoft Word and Excel and Adobe Acrobat and Flash, among others.

Layout

Layout

Template ,-EL'
.:" \ - Email

[ Printer
Data Model |—» »

Style Template Fax

[

Subtemplate

" O

Word, Excel, PDF, Flash, other
layout tools

How You Access and Modify Report Components

To create or edit reports, you must access the business intelligence (BI) catalog. In the catalog, objects of type Report
represent the report definition, which includes report properties and layouts.
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Data models are separate objects in the catalog, usually stored in subfolders called Data Models.

Accessing the Bl Catalog

You can access the Bl catalog in any of the following ways:

In the Reports and Analytics work area, click Browse Catalog to open the Bl catalog, and find your report or
data model in the Folders pane.

In the Reports and Analytics work area, find your report and select More to go to the report directly in the
catalog. The data model associated with the report should be in the Data Models subfolder within the same
folder as the report.

- Signin to the application directly (for example: http: //host:port/analytics/saw.dl1) to open the catalog.

- Sign in to the Analytics Publisher server directly (for example: http://hostname.com: 7001/xmlpserver) t0 Open
the catalog.

o Alternatively, once you are in the catalog using another method, for example, through the Reports
and Analytics work area, change the final node of the URL. For example, change (http: //host:port/
analytics/saw.dll) t0 xmlpserver. SO the URL you use would be: http://host:port/xmlpserver.

Predefined Reports

A special Customize option is available only:

For predefined reports, not data models.
- Through direct access to the server using the /xmi1pserver URL. When you find your report in the Bl catalog,
select Customize from the More menu.

The Customize option automatically creates a copy of a predefined report and stores it in the Shared Folders > Custom
folder within the catalog. The new report is linked to the original, so that when users open or schedule the original, they
are actually using the copied version.

If you don't have access to the Customize option or don't want the original version linked to the new report, make a copy
of the predefined report and save it in the Custom folder.

Predefined Data Models

Don't edit predefined data models. Instead, copy the data model into the Custom folder and edit the copy. You can't
create a new data model based on the transactional tables.

Related Topics
« Where to Save Analytics and Reports

« What happens to modified analytics and reports when a release update is applied?

Reflect Changes from Edited Reports Sooner

When you use the Customize option to edit a predefined report, your changes won't be reflected until a refresh that
happens every 24 hours. For changes to take effect sooner, use profile options to change the refresh interval.

The refresh applies your changes to Oracle Fusion Cloud Applications, but you can immediately see your changes in
Microsoft Word and Oracle Analytics Publisher. For example, you download a predefined .rtf layout template and edit
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the file in Word. You can see the modified output using the preview in Word. After you upload the .rtf file to the catalog,
you can open the report in Analytics Publisher and see your changes. But, if you're accessing the report from Fusion
Applications, you see the updated output only after the refresh.

When you're done configuring and testing reports, use the same profile options to turn the refresh back to every 24
hours. But even if you don't, the refresh automatically resets to 24 hours when it's been more than 8 hours since you set
the profile options. The 24-hour refresh interval helps optimize performance.

Create Profile Options to Control the Refresh

Your profile options can apply to all workflow tasks, a product family, or a product. Based on the scope you want, your
profile option must have a profile option code that follows a certain format.

Scope Profile Option Code Examples
Global BIP_CLIENT_REFRESH_TIME BIP_CLIENT_REFRESH_TIME
Product Family BIP_CLIENT_REFRESH_TIME_<FAMILY> - BIP_CLIENT_REFRESH_TIME_FIN

BIP_CLIENT_REFRESH_TIME_HCM
BIP_CLIENT_REFRESH_TIME_PRC
BIP_CLIENT_REFRESH_TIME_PRJ
BIP_CLIENT_REFRESH_TIME_SCM

Product BIP_CLIENT_REFRESH_TIME_<FAMILY>_ » BIP_CLIENT_REFRESH_TIME_FIN_AP
<PRODUCT>
BIP_CLIENT_REFRESH_TIME_HCM_PER
BIP_CLIENT_REFRESH_TIME_PRC_PON
BIP_CLIENT_REFRESH_TIME_PRJ_PJE
BIP_CLIENT_REFRESH_TIME_SCM_EGO

The profile options with a smaller scope take precedence. For example, you have profile option A with a global scope
and profile option B with a product scope. If you're currently configuring notifications for a particular product, use
profile option B to adjust the refresh time just for that product. But based on profile option A, the refresh is still at 24
hours for all other configurable notifications in all other products. Profile option B takes precedence over profile option
A only for that one product.

Tip: To find the product family or product code, go to the Setup and Maintenance work area. Use the Manage
Taxonomy Hierarchy task in the Application Extensions functional area for any offering. In the hierarchy, expand
the root node and then the Oracle Fusion node. Find the row for the family or product and look in the Module Key
column for the code.

Now you're ready to create your profile options!

1. In the Setup and Maintenance work area, go to the Manage Applications Core Profile Options task in the
Application Extensions functional area for your offering.

2. Onthe Manage Applications Core Profile Options page, click the New icon.

3. On the Create Profile Option page, enter the profile option code in the format that corresponds to the scope
you want.

4. Enter a display name that you can easily remember to help you find the profile option later.
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From the Application list, select Oracle Middleware Extensions for Applications.

From the Module list, select Application Core.

Specify a start date.

Click Save and Close.

On the Manage Applications Core Profile Options page, make sure that your new profile option is selected in

the Search Results: Profile Options subsection.

10. In the <Profile Option>: Profile Option Levels subsection, select the Enabled and Updatable check boxes for
the Site level.

11. Save your work.

VR3O U

Set the Refresh Interval

In the Setup and Maintenance work area, go to the Manage Applications Core Administrator Profile Values task in
the Application Extensions functional area. Set your profile option at the Site level and enter 15 or higher for the refresh
interval in minutes. If you enter 15, your changes are reflected in Fusion Applications 15 minutes after they're saved

in the Bl catalog. For example, 15 minutes after you upload an edited .rtf layout template to the catalog, or after you
update report properties in Analytics Publisher.

CAUTION: Make sure to enter a whole number.

When you're done making and testing your changes, set the profile option back to 1440, which is 24 hours in minutes. If
you forget and leave your profile option as is for longer than 8 hours, don't worry! At that point, the profile option resets
itself back to 1440 minutes.

Related Topics
- Update Existing Setup Data

« Set Profile Option Values
« Modules in Application Taxonomy

Where to Save Analytics and Reports

You save analyses, dashboards, and reports in the catalog, along with other objects like prompts and filters.

Besides the hierarchy of folders organized by product family, another important folder is Custom, found in Shared
Folders. This is where you save the analytics and reports you create or edit for others to use.

Shared Folders and the Custom Subfolder

Anyone with the correct access can get to objects stored in Shared Folders. If you have the appropriate roles, you
can save in Shared Folders so that your objects are available for other users. You should save objects in the Custom
subfolder, and use the product family subfolders to organize and publish analytics and objects for the correct audiences.

Here are a few things to know while working with analytics in the catalog. Keep all modified analyses and reports in
the Custom folder. Directly edit predefined analytics only when it's necessary to make sure that any references to the
analysis or dashboard still work properly.

Preserve modified predefined objects during updates, which can make changes to predefined analytics,
reports, and other objects outside the Custom folder. You might lose changes saved outside the Custom folder
during updates.
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- You can easily find modified objects if they're not spread around the catalog.
- You can edit objects in the Custom folder without compromising security on the original objects.

For predefined reports only, you can use a special Customize option to copy the report and also the folder
structure and permissions. The copy is linked to the original, so editing the copy is like directly editing the
original.

When you copy an object into the Custom folder, the copied object inherits the permission settings of the Custom
folder. An administrator can reset the permissions on the object and the folder that it's in.

Note: When you create folders in the catalog, don't use special characters (~, 1, #,%, %, *, & *,+, ; |, ", \\, <, >, 2, ,, /)
in their names.

My Folders

My Folders is your personal storage; you're the only one who can access anything that you save there. What you save
there is available in the Reports and Analytics work area, but not in My Folders in the Reports and Analytics panel tab on
any other work area. But an exception is when you create an analysis using the wizard in the Reports and Analytics work
area. If you save a wizard analysis in My Folders, it's available in any panel tab that appears in any work area.

Note: Don't store analyses or reports in the predefined Temp folder in My Folders. That folder is used by Analytics
Publisher and purged automatically every 24 hours.

Create Folders

Create folders in Custom or My Folders.

To create folders:

1. Inthe catalog, navigate to the desired location of the new folder in the Folders pane.
2. Inthe catalog toolbar, click New, and select Folder.
3. Inthe New Folder dialog box, enter the folder name, and click OK.

Automatically Created Folders

If conflicts are detected during upgrade, folders named backup_nnn are automatically created in the catalog. After
reviewing and resolving any conflicts, Oracle recommends that you manually delete the backup folders from the
catalog. You can contact your help desk to request an automated removal if you have many folders to delete.

Related Topics
« What happens to modified analytics and reports when a release update is applied?

What happens to modified analytics and reports when a
release update is applied?

Updates don't affect the Custom folder or My Folder in the catalog, anything saved there is preserved in updates.
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This includes analytics and reports you edited or created. But anything saved outside those folders, in the predefined
catalog, is preserved only if the update doesn't include doesn't include a new version of those objects.

If an update includes a new version of a predefined object that you edited outside the Custom folder, the changes you
made are saved as a new object. The new version from the update overwrites the existing predefined object. And a copy
of the existing object (with your edits) is automatically created in the same folder, with a new name that indicates it's a
new version.

If the update includes a new version of both the predefined object and a folder in its file path, the new folder name,
along with the new version of the object, overwrites the existing predefined folder and object. And a copy of the existing
folder (along with your edited object) is automatically created. The folder is renamed to indicate that it's a new version,
but your edited object isn't renamed.

If folders named backup_nnn are automatically created in the catalog due to conflicts, after reviewing and resolving any
conflicts, Oracle recommends that you manually delete the backup folders from the catalog. You can contact your help
desk to request an automated removal if you have many folders to delete.

Note: Future updates won't affect renamed objects or anything within a renamed folder.

Work with Analyses and Reports

Create a Supplier Purchase Order Analysis

This example demonstrates how to create an analysis that shows details of the purchase orders for a specific supplier.

The following table summarizes key decisions for this scenario.

Decisions to Consider In This Example
Which subject area to use? Procurement - Purchasing Real Time
What columns to include? Year, Business Unit, Supplier, Name, Payment Terms, Order, UOM, Line, Ordered Quantity, Purchase

Order Distribution Amount

Which layout to use? Table
Does the report need sections? No
Does the report need highlighting? Highlight ordered quantity above 1000 and below 20.

Create the Analysis

1. Navigate to the Reports and Analytics work area.
2. On the Create Analysis: Select Columns page, expand the Procurement - Purchasing Real Time folder.
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40.
41.
42,
43.
44.

Click Create and select Analysis if not already selected.

In the Select Subject Area window, select the Procurement - Purchasing Real Time subject area.
Expand the Time - Approved Date folder.

Select Year and click the Add button to move the column to the Selected Columns area.
Expand the Procurement BU folder.

Select Business Unit and move it to the Selected Columns area.

Expand the Supplier Profile folder.

Select Supplier and move it to the Selected Columns area.

Expand the Supplier Contact folder.

Select Name and move it to the Selected Columns area.

Expand the Payment Terms folder.

Select Payment Terms Name and move it to the Selected Columns area.

Expand the Purchase Order Header Detail folder.

Select Order and move it to the Selected Columns area.

Expand Purchase Order Lines, then expand the Purchase Order Line Detail folder.

Select UOM and move it to the Selected Columns area.

In the same folder select Line move it to the Selected Columns area.

Expand Purchase Order Lines, then expand the Purchase Order Line folder.

. Select Ordered Quantity and move it to the Selected Columns area.

Expand Purchase Order Distributions, then expand the Purchase Order Distribution folder.

. Select Purchase Order Distribution Amount and move it to the Selected Columns area.

Click Next.

On the Create Analysis: Select Views page, enter "Supplier Purchase Order Analysis" in the Title field.
Next to the Table field, click None to open the Table menu.

Select Table (recommended).

Check the box for Preview.

Click Next.

On the Create Analysis: Edit Table page, click Next.

. On the Create Analysis: Edit Graph page, in the Sort region click Add Sort.
. Select Order, then Ascending.

In the Filter region click Add Filter.
Select Supplier, then Allied Manufacturing in the Value column.

. Click Next.

Open the choice list for Add Column Format and select Ordered Quantity.

Now enter 20 for the first Threshold and 1000 for the second Threshold.

Click Next.

On the Create Analysis: Save page, Save In region, enter "PO Details for Allied Manufacturing" in the Analysis
Name field, enter a description, and then select My Folders.

Click Submit.

In the Confirmation window, click OK.

Expand My Folders to locate your analysis.

Select your report and click View.

Review your analysis.

Related Topics

How You Configure Purchasing Document Reports

You can copy and configure new versions of the delivered purchasing document report templates. Use the report
creation capabilities of Oracle Analytics Publisher, and Oracle Analytics Publisher Desktop.
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Aspects of copying and configuring delivered purchasing document report templates that are explained in this topic
include:

Report templates.
How You obtain Procurement data source.
Data models.

- General steps to copy and configure a report.

Report Templates

Two predefined purchasing document report templates are delivered: Purchase Order PDF Report and Purchase
Agreement PDF Report.

The reports have two main elements:

Procurement data source.
Report layout template.

Obtain the delivered report templates in Oracle Analytics Publisher, using the following path: Catalog/Shared Folders/
Procurement.

You can configure new versions of the delivered reports by adding fields to the report layout, to include reporting
attributes not shown in the delivered versions, such as:

- Attributes from the delivered data model.
- Additional attributes from tables not available in the delivered data model.

How You Obtain Procurement Data Source
You can obtain the procurement data source (represented as an XML file) directly from Oracle Analytics Publisher.

There are two ways to extract the data source from Oracle Analytics Publisher:

- You can find the data models in the this path: Catalog > Shared Folders > Procurement > Purchasing > Data
Models. There's a data model for purchase orders and a separate one for purchase agreements. You can export
the data source from these data models by navigating to Edit > Data. Specify values for the parameters and
then select View to see the XML. Use the Export button to save the XML.

- Alternatively, you can extract the data source from the provided reports. First, you must enable XML as an
output parameter for the layout:

a. Navigate to Catalog > Shared Folders > Procurement > Purchasing, create a custom copy of the report
you want to work with and then click Edit from the custom version you just created (placed in the Custom
> Procurement > Purchasing folder by default).

b. Select View a list.

c. Inthe Output Formats dropdown, select Data (XML).

d. Open the report using either the Report Viewer (View Report button) or navigate to Open > Shared
Folders > Custom > Procurement > Purchasing.

Note: To enable the View Report button, you must set the properties of the report to Run Report
Online.

e. Enter values for the parameters. When the results are displayed, navigate to Actions > Export > Data. You
will be prompted to save the data source as an XML file.
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Whether you use option 1 or option 2 to obtain the data source, you must provide values for these parameters to
generate the corresponding XML file for purchase orders:
- Sold-to LE
Document Number
- Change Order Number
Is Document in Draft Status? (Y/N)

To extract sample data from the purchase agreement data model, you must provide values for these parameters:

Procurement BU
Document Number
- Change Order Number
Is Document in Draft Status? (Y/N)

Data Models

Two data models are delivered, one for each purchasing document report: Purchase Order Data Model, and Purchase
Agreement Data Model. Obtain them from Oracle Analytics Publisher, using the following path: Catalog/Shared
Folders/Procurement.

Use the data models to:

- See all of the fields that can be included in a report.
Retrieve fields from other tables that aren't included in the delivered data models.

Make changes to the data models for the two purchasing document types independent of each other.

How You Copy and Configure a Purchasing Document Report

To copy and configure a purchasing document report follow these general steps.

1. Use Oracle Analytics Publisher to:

Obtain the delivered data model and report template appropriate to the purchasing document type.
Make a copy of them to configure into a new version, preserving the delivered versions unchanged.
Edit the data model and export the XML.

d. Download the report template.
2. Use Oracle Analytics Publisher Desktop, in Microsoft Word, to:

n oo

a. Import the data model to the copy of the report template.
b. Modify the report template to add fields to the report that aren't a part of the delivered report.
3. Use Oracle Analytics Publisher to:

a. Upload the modified report template to the catalog, making it available to other users.

The modified report template displays in the Configure Procurement Business Function task. You can find the task in
the Setup and Maintenance work area, Procurement Foundation functional area. For each affected business unit, you
can associate the modified report template with the appropriate purchasing document type.
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6 Infolets

Overview of Infolets

An infolet is a small interactive widget that gives you key information and shows you what's going on in the areas you
work on. You might also find something in an infolet that you need to follow up on.

You can use infolets arranged in tabs in the Analytics section of your home page. If you're using a panel or banner
layout, use the page control icons to use the infolets.

Here are a few things to know about infolets.

- Infolets have a front view, and might have a back and expanded view. Use the Back View, Front View, and
Expanded View icons at the bottom corners of an infolet to open these views.

« Your current infolet view persists as the default view the next time you sign in. For example, if you viewed a
back view of the infolet in your last session, you will see the same infolet view by default in your next session.

- Some infolets might also contain links to detailed reports. You can click anywhere in the infolet area to drill
down to the detailed report.

- You can also personalize the infolets. For example, you can move or hide them on the infolets page.

- If you don't see infolet pages on your home page, then your administrators must have disabled them to show
on the home page.

Note: Some SCM or Procurement Cloud infolets might function differently from other infolets.

Here's how an infolet page looks.
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Personalize Infolets

You can personalize the infolets on your infolets page, such as you can edit their titles and views, move them, or hide or
show specific infolets on the infolets page.

Edit Infolet Titles and Views

1. Click the Actions icon on the top right corner of the infolet, and select Edit Title and Views.
2. Edit the infolet title, and enable or disable the infolet views.
3. Click Save and Close.

Reorder Infolets

You can change the position of an infolet within an infolet page.

1. Click the Infolet Repository icon, and select Reorder Infolets.
2. Inthe Reorder Infolets dialog box, select the infolets, and use the arrows to reorder them.

I Tip: To select multiple infolets, press the Ctrl key, and then select them.

3. Click Apply.
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Hide or Show Infolets

To hide an infolet from an infolet page, click the Infolet Repository icon, and deselect the infolet from the list of
infolets.

Tip: Alternatively, click the Actions icon on the top right corner of the infolet, and select Hide.

To show a hidden infolet on an infolet page, click the Infolet Repository icon, and select the infolet from the list of
infolets.

Related Topics
« Configure Infolet Display

Configure Infolets

Overview of Configuring Infolets

You can configure infolets that aggregate key information for a specific area, for example, personal profile.

Your users use infolets arranged in tabs in the Analytics section of the home page. Or, if it's a home page with a panel or
banner layout, they use the page control icons.

If your users don't find infolet pages on the home page, you can enable them by using the Home Configuration tab in
the Structure work area. Let's look at some tasks you can do to configure infolets.

- Create infolets.
- Add content to infolets. For example, you can add a task flow or a performance tile report, and if an infolet
contains a performance tile report, then you can add a link to a detailed report in the same infolet.

Note: In the context of infolets, a report is an analysis, not an Analytics Publisher report.

Edit infolets. For example, edit infolet content and add, change, or remove link to detailed report.
Delete infolets.

But before you start creating and editing infolets, here are a few things to keep in mind:

- You can add analyses from the catalog to an infolet, but not Analytics Publisher reports, or other objects like
filters or prompts.

- To create or edit infolets, you must first either create and activate a sandbox, or activate an existing one. But
make sure the sandbox has the Page Composer tool selected. If you want to make changes in a context layer
that isn't the default layer, Site, you must create a separate sandbox just to use Page Composer in it. You can
then change the context layer from Site to the other layer. For example, to create or edit infolets for a user with
a specific job role, you must select the Job Role context layer.

- You can validate your changes in the sandbox in preview mode before you publish it.
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Related Topics
» Configure Infolet Display

« Best Practices for Using Page Composer in Sandboxes

Create Infolets

® Watch video

Use infolet pages to create infolets. You can create an infolet, add content to it, and link detailed reports. For some
product-specific infolet pages, you can't create infolets.

1. Activate a sandbox that has the Page Composer tool in it.

2. Open an infolet page.

3. Click your user image or name in the global header, and on the Settings and Actions menu, select Edit Pages.
4. C(lick the Infolet Repository icon, and select Create Infolet.

Note: If you can't find the Create Infolet menu item, it means you can't create infolets for this page.
5. Enter a title for the infolet and set its views.

o Specify the dimensions for the front view.
o Enable or disable the back view.

o Enable or disable the expanded view, and specify its dimensions. The dimensions of the front and the
back views must be the same, but the expanded view must be bigger because it displays more details.

6. Click Save and Close. You can now add content to infolets.

Add Content to Infolets

You can add content to the infolet's front, back, or expanded view. You can't add a business intelligence dashboard to an
infolet because a dashboard report is generally bigger than an infolet.

1. Select the infolet's view that you want to add content to.

Note: To open infolet's back view, click the Back View icon on the bottom right corner of the infolet. And to
open expanded view, click the Expanded View icon on the bottom right corner of the infolet's back view.

2. (Click Add Content on the infolet. You can find this button on any of the infolet's views, but only if you don't
have any existing content in that view.

3. Search and select a performance tile or a task flow, and click Add. You can browse the business intelligence (BI)
catalog to find the analytics and reports that you want to add.

4. Close the Add Content dialog box. You can now add detailed reports to the infolet.

Link Detailed Reports to Infolets

To provide detailed information about a subject matter on an infolet, you can add a link to a detailed report. After you
add the link, your users can click anywhere in the infolet area to drill down to that detailed report. The detailed report
doesn't replace the existing infolet content.
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First, add a performance tile report to the infolet content, and then follow these steps:

Click the Actions icon on the top right corner of the infolet, and select Link Detailed Report.
On the Detailed Report page, click Add Content.

Search and select a report, and click Add to add it to the infolet.

Close the Add Content dialog box.

Click Done. You can now publish the sandbox.

Publish the Sandbox

A WN

1. Preview the infolet's front view, drill down to the detailed report, and then preview the back and the expanded
views.

2. After you made changes, click Close to leave Page Composer.
3. Test your changes and publish the sandbox to make the new infolet available to your users.

Related Topics
- Why don't | see infolets in the Analytics section of the home page?

» Overview of Sandboxes

« Create and Activate Sandboxes

-« Best Practices for Using Page Composer in Sandboxes

« Why can't | see application changes made in previously published sandboxes in my current sandbox?

Edit and Delete Infolets

On the infolet page, use the options available on each infolet to edit infolet content and delete infolets.

1. Activate a sandbox that has the Page Composer tool in it.
2. Open aninfolet page.
3. Click your user image or name in the global header, and on the Settings and Actions menu, select Edit Pages.

Note: After you're done making changes, click Close to leave Page Composer, test your changes, and publish
the sandbox.

Edit Infolet Content

1. Click the Actions icon on the top right corner of the infolet, and select Edit Content.

Note: To edit the infolet content of the back or expanded view, open the view and use the Actions icon on
that view.

2. (Click Add Content to replace the existing content of the infolet.

3. Search and select a performance tile or a task flow, and click Add. You can browse the business intelligence (BI)
catalog to find the analytics and reports that you want to add.

4. Close the Add Content dialog box.
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Edit Title and Views

To edit title and views of an infolet, click the Actions icon on the top right corner of the infolet, and select Edit Title and
Views.

Edit or Remove Detailed Report
You can edit or remove the detailed report.

1. Click the Actions icon on the top right corner of the infolet, and select Edit Detailed Report.
2. On the Detailed Report page, you can edit or remove the detailed report.

o To edit, click Edit Report and make changes to the detailed report.

o Toremove, click Remove Report.
3. Click Done.

Edit Infolet Visibility

You can show or hide an infolet on the infolet page. To edit the visibility settings of an infolet, do these steps:

1. Click the Actions icon on the top right corner of the infolet, and select Edit Visibility.
2. Select one of these options:

o Yes: The infolet appears on the infolet page.
o No: The infolet doesn't appear on the infolet page.

o EL Expression: The evaluation of the EL expression decides whether the infolet appears on the infolet
page.

Delete Infolets
To delete an infolet, click the Actions icon on the top right corner of the infolet, and select Delete.

CAUTION: You can't easily retrieve an infolet once you delete it. But if you have accidentally deleted any infolet, don't
worry. Contact My Oracle Support at https://support.oracle.com.

Related Topics
« Overview of Sandboxes

« Create and Activate Sandboxes

Examples of EL Expressions

You can use EL expressions to configure the visibility settings of various elements like groups, page entries, infolets, or
announcements on the Ul for users with specific roles.

For example, you can use EL expressions to show or hide a group or page entry on the Navigator and the home page, or
show or hide an infolet or an announcement on the home page. The evaluation of the EL expression decides whether
these elements are displayed for users with specific roles.
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Scenario
This table shows examples of how you can use EL Expressions to show or hide specific Ul elements for specific users.

Who can see the group or page entries EL Expression and Example

Only users having any of the specificroles = #{securityContext.userInRole['<Role_Name>']}

#{securityContext.userInRole['CUSTOM FND_ APPLICATION ADMINISTRATOR JOB,
CUSTOM_SVC_INTERNAL_HELP_DESK_MANAGER _JOB']}

Only users not having any of the specific #{! (securityContext.userInRole['<Role_Name>']}

roles
#{! (securityContext.userInRole[' CUSTOM_FND_APPLICATION ADMINISTRATOR_ JOB,
CUSTOM_SVC_INTERNAL_HELP DESK_MANAGER JOB'])}

Only users having all of the specific roles #{securityContext.userInAllRoles['<Role_ Name>']}

#{securityContext.userInAllRoles['CUSTOM FND_APPLICATION ADMINISTRATOR JOB,
CUSTOM_SVC_INTERNAL HELP DESK MANAGER JOB']}

Only users not having all of the specific #{! (securityContext.userInAllRoles['<Role_Name>']}

roles
#{! (securityContext.userInAllRoles['CUSTOM FND APPLICATION ADMINISTRATOR JOB,
CUSTOM_SVC_INTERNAL HELP DESK_MANAGER JOB'])}

Here are a few things to keep in mind when you use EL expressions.

- Use an EL expression that can be evaluated from any page because the Navigator is used on all pages. So, don't
use product-specific EL expressions.

- Don't include spaces or double quotes in EL expressions.

- Don't copy EL expressions from a word document and paste directly in the expression editor. Doing so might
introduce hidden characters in your EL expression, causing formatting issues and unexpected action. Instead,
use a text editor or manually type the EL expression in the editor.

Related Topics
- Configure the Navigator and Page Entries on the Home Page for Navigation

» Create Roles in the Security Console

FAQs for Infolets

Why don't | see infolets in the Analytics section of the home page?

That's probably because the infolet page is hidden.
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Change the visibility setting of the infolet page using the Home Configuration page of the Structure work area. To open
this page, click Navigator > Configuration > Structure, and then click the Home Configuration tab.

Related Topics
» Configure Infolet Display

How can | rename an icon for an infolet page in the page control
on the home page?

You can rename an icon for an infolet page using the Home Configuration page of the Structure work area. To open this
page, select Configuration > Structure from the Navigator menu, and then click the Home Configuration tab.

Related Topics
» Configure Infolet Display

What's the difference between a performance tile report and a
detailed report added to the infolets content?

Performance tile report shows data in the small infolet format. When you add a performance tile report to an infolet,
users can see only the summary information about the subject matter. But this report doesn't provide detailed
information.

To provide detailed information about the subject matter on the same infolet, add a link to a detailed report. Users can
click this link to gather more information.
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7 Workflow Notifications

Configure Procurement Workflow Notifications

As part of certain business flows with workflow tasks, the application automatically sends email or in-application
notifications to your users, or to people your users do business with.

For example, when a user submits a requisition, the approvers receive an email with the approval request. For some
flows, configurable Oracle Analytics Publisher reports determine the email and in-application notification content and
format. For some workflow tasks, you can enable these configurable notifications to be used instead of the standard
notifications.

Procurement business flows with configurable notifications include the following workflow tasks:

Negotiation invitation
Purchase order approval
Purchase order change order approval
Requisition approval
Requisition reapproval (change to lines by requester, change to lines by buyer)
- Seller negotiation award decision
- Seller negotiation bid disqualification
- Seller negotiation change schedule
- Seller negotiation invitation
External Supplier Registration Approval Decision
In addition to getting notifications in email, users can also view in-application notifications by:
- Clicking the Notifications icon in the global header and opening a notification.
- Going to the Worklist: Notifications and Approvals work area and opening a notification.

- Clicking the In-App Notification link at the end of an email notification.

Process Overview

The process to generate configurable email and in-application notifications is the same as generating other types of
report output. The process involves various types of objects in the business intelligence catalog, including data models,
subtemplates, style templates, and reports.

This figure shows how these objects work together to generate the output used for email and in-application
notifications.
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Data Source: Stores the attributes and attribute values for business objects and transactions in the application

Data Model: Determines which attributes from data sources are available to be included in the notification and
how that data is retrieved

Subtemplate: Provides common components, for example a branding logo and buttons, that can be reused in
multiple reports

Style Template: Provides styles, such as the type of lines and fonts to use in tables, or the font type, size, and
color to use for headings

Report: Contains a layout template that determines:

o Which attributes appear in the notification, from the data model used for the report

o What the notification looks like, using components from the subtemplate and styles from the style
template used for the report

HTML.: Is the output generated from the report

Email Notification: Is sent to users as part of a business flow, with the HTML output embedded in the email
body

In-Application Notification: Has the HTML output embedded in the application user interface

Each workflow task with configurable notifications has a corresponding predefined report in the Bl catalog. For
example, the Requisition Approval Email Report contains the Requisition Approval Email Layout and uses the
Requisition Approval Email Data Model. The generated output is included in emails that are sent to users for requisition
approval.

Notification Modifications

After you enable configurable workflow notifications, the predefined reports and related objects in the Bl catalog work
by default. The report-based notifications provide the same information as the standard notifications, but in a format
optimized for mobile devices. To modify the notifications, you can edit copies of the predefined reports, data models,
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and subtemplate (but not the style template). You proceed as you would to edit any report, data model, or subtemplate
in the catalog, for example:

1. Find a predefined report for procurement in the Bl catalog.
2. Use the Customize option to create a copy, or copy the report and paste it within the Custom folder.
3. Edit the copied report layout template.

Note: The configurable, report-based notifications are delivered in a format optimized for mobile devices. If your
organization has approvers using mobile devices, minimize making modifications that increase the number of
columns in tables, and test all such modifications thoroughly on applicable mobile devices before deploying the
changes.

For more information about creating and editing reports, see the Oracle Fusion Cloud Procurement Creating and
Administering Analytics and Reports for Procurement guide, available on the Oracle Help Center. You should get familiar
with Oracle Analytics Publisher in general before modifying configurable notifications. Aspects specific to configurable
notifications include:

- You use only the Template Builder for Word add-in to edit the .rtf template in Microsoft Word, not the layout
editor or other tools available for creating and editing report layout.

- You usually edit a copy of predefined layout templates, rather than create reports or layout templates.

Security

To modify reports and data models for workflow notifications, you must have the Bl Administrator related privileges.

Setup

If required, use the Offerings work area, Procurement offering to enable the configurable notifications feature.

- Configure Negotiation Invitation Notification with Oracle Analytics Publisher, found in the Sourcing functional
area

Also. download and install the Template Builder for Word add-in.

For configurable email notifications, make sure that the email domain setup is correct in Oracle Analytics Publisher so
that the emails get sent.

Note: Files attached to a notification by approvers during an approval flow aren't attached to the underlying
document either for requisitions or purchase orders and therefore these attachments aren't accessible from the
requisitions or purchasing documents user interface.

Related Topics
« More About Oracle Transactional Business Intelligence Components

« Set Up for RTF and Excel Report Layout Templates
« Overview of Notifications and Approval Workflows
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Reflect Changes from Edited Reports Sooner

When you use the Customize option to edit a predefined report, your changes won't be reflected until a refresh that
happens every 24 hours. For changes to take effect sooner, use profile options to change the refresh interval.

The refresh applies your changes to Oracle Fusion Cloud Applications, but you can immediately see your changes in
Microsoft Word and Oracle Analytics Publisher. For example, you download a predefined .rtf layout template and edit
the file in Word. You can see the modified output using the preview in Word. After you upload the .rtf file to the catalog,
you can open the report in Analytics Publisher and see your changes. But, if you're accessing the report from Fusion
Applications, you see the updated output only after the refresh.

When you're done configuring and testing reports, use the same profile options to turn the refresh back to every 24
hours. But even if you don't, the refresh automatically resets to 24 hours when it's been more than 8 hours since you set
the profile options. The 24-hour refresh interval helps optimize performance.

Create Profile Options to Control the Refresh

Your profile options can apply to all workflow tasks, a product family, or a product. Based on the scope you want, your
profile option must have a profile option code that follows a certain format.

Scope Profile Option Code Examples
Global BIP_CLIENT_REFRESH_TIME BIP_CLIENT_REFRESH_TIME
Product Family BIP_CLIENT_REFRESH_TIME_<FAMILY> - BIP_CLIENT_REFRESH_TIME_FIN

BIP_CLIENT_REFRESH_TIME_HCM
BIP_CLIENT_REFRESH_TIME_PRC
BIP_CLIENT_REFRESH_TIME_PRJ
BIP_CLIENT_REFRESH_TIME_SCM

Product BIP_CLIENT_REFRESH_TIME_<FAMILY>_ » BIP_CLIENT_REFRESH_TIME_FIN_AP
<PRODUCT>
BIP_CLIENT_REFRESH_TIME_HCM_PER
BIP_CLIENT_REFRESH_TIME_PRC_PON
BIP_CLIENT_REFRESH_TIME_PRJ_PJE
BIP_CLIENT_REFRESH_TIME_SCM_EGO

The profile options with a smaller scope take precedence. For example, you have profile option A with a global scope
and profile option B with a product scope. If you're currently configuring notifications for a particular product, use
profile option B to adjust the refresh time just for that product. But based on profile option A, the refresh is still at 24
hours for all other configurable notifications in all other products. Profile option B takes precedence over profile option
A only for that one product.
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Tip: To find the product family or product code, go to the Setup and Maintenance work area. Use the Manage
Taxonomy Hierarchy task in the Application Extensions functional area for any offering. In the hierarchy, expand
the root node and then the Oracle Fusion node. Find the row for the family or product and look in the Module Key
column for the code.

Now you're ready to create your profile options!

1. Inthe Setup and Maintenance work area, go to the Manage Applications Core Profile Options task in the
Application Extensions functional area for your offering.

2. On the Manage Applications Core Profile Options page, click the New icon.

3. On the Create Profile Option page, enter the profile option code in the format that corresponds to the scope
you want.

4. Enter a display name that you can easily remember to help you find the profile option later.

5. From the Application list, select Oracle Middleware Extensions for Applications.

6. From the Module list, select Application Core.

7. Specify a start date.

8. (lick Save and Close.

9. On the Manage Applications Core Profile Options page, make sure that your new profile option is selected in

the Search Results: Profile Options subsection.

10. In the <Profile Option>: Profile Option Levels subsection, select the Enabled and Updatable check boxes for
the Site level.

11. Save your work.

Set the Refresh Interval

In the Setup and Maintenance work area, go to the Manage Applications Core Administrator Profile Values task in
the Application Extensions functional area. Set your profile option at the Site level and enter 15 or higher for the refresh
interval in minutes. If you enter 15, your changes are reflected in Fusion Applications 15 minutes after they're saved

in the Bl catalog. For example, 15 minutes after you upload an edited .rtf layout template to the catalog, or after you
update report properties in Analytics Publisher.

CAUTION: Make sure to enter a whole number.

When you're done making and testing your changes, set the profile option back to 1440, which is 24 hours in minutes. If
you forget and leave your profile option as is for longer than 8 hours, don't worry! At that point, the profile option resets
itself back to 1440 minutes.

Related Topics
« Update Existing Setup Data

« Set Profile Option Values
- Modules in Application Taxonomy
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Best Practices for Content and Layout in Workflow
Notifications

Here are some recommendations, tips, and reminders regarding the content and format of your configurable workflow
notifications. Keep these in mind while you work on layout templates.

Follow the General Structure

In general, the workflow notifications contain a set of components that are displayed in a certain order. When you
modify notifications, try to keep to this general structure and don't remove essential elements such as the action
buttons.

The callouts in this figure identify the email notification components listed in the following table.
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The callouts in this figure identify the in-app notification components listed in the following table. In addition to
describing each component, the table also indicates if the component appears in the email notification, in-app

notification, or both.
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@nn Aucrd w | Approve Mt
Task Approval @

3,700.00usD

Vision Corporation

Details
Emily Thome

Exanigds of & Wik baf Shpioval
Task Information

Dwiail Line Arncut
1. Exampde A 2 200000

1,000.00
500,00
Tetal 3.700,00
Callout Component Notification Type
1 Buttons with the primary actions to take on In-app

the task, such as Approve and Reject. These
buttons aren't part of the configurable, report-
based notification content.

2 Notification header listing key attributes of the = Both
workflow task and the associated transaction.

3 Buttons for the primary actions to take on the Email
task, such as Approve and Reject.

4 Notification body that usually includes Both
transaction and line level details, displayed in
tables or sets of attributes with corresponding
values. The data model for the report restricts
the total number of rows displayed in some
of the tables. If the limit is exceeded, the table
footer provides a link to the transaction details
page, where users can view all the rows. To
change this limit, you can edit a copy of the
data model.

5 Approval history, including any attachments Email (or both, in rare cases)
that users in the history uploaded for the task.
You can't edit the approval history component,
which usually appears in the body of only email
notifications. For in-app notifications, you can
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Callout Component Notification Type

usually view the history by clicking the Actions
button and selecting History.

6 Buttons for the primary actions again. Email

7 Alink to the corresponding transaction page, Email
and another link to the in-app notification.

Keep Mobile in Mind

Because users can view the workflow notifications on mobile devices, always consider mobile first and keep the
notifications as simple as possible. For example:

Don't put too much content horizontally, such as too many columns in tables.

Keep all text, including attributes and column headings, as short as possible.

- Center align lists of attributes and their values, if they appear outside tables.

Note: For workflow tasks with configurable notifications, make sure that the Hide End User Web URL in
notifications check box is selected in BPM Worklist. If not, a default first line will appear in the emails, in addition to
what comes from the report layout template. It's best to hide this additional content because it might cause emails to
not render well, especially when viewed from mobile devices.

Make sure to test your email notifications on mobile devices. As part of your testing, confirm that the default line about
accessing the task in the Workspace Application isn’t showing up.

Related Topics
« More Setup for Workflow Email Notifications

« Create RTF Templates Using the Template Builder for Word

Add a Branding Logo and Change Other Shared
Components in Workflow Notifications

A predefined subtemplate has common components for all workflow notifications based on predefined report layouts.
You can edit these shared components so that the same changes apply to your notifications.

Here are some of the shared components in the subtemplate:

Branding logo, if you add one to the subtemplate, which would appear as the first component in the email body.
The logo appears in email notifications only.

- Action buttons in email notifications.

Links at the end of the email notification, one to the corresponding transaction page, and another to the in-app
notification.
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For example, you can add a branding logo in the designated place in the subtemplate, or change the text on the buttons
and links.

Note:

- When you make a copy of a predefined layout template to edit, the copy automatically inherits the same

predefined subtemplate.

Other than this central subtemplate for all notifications, you might also find predefined subtemplates specific
to a product family. We talk about the central one here, but you would generally follow the same steps for other
subtemplates.

- You must edit a copy of the subtemplate in the Custom folder of the Bl catalog. Don't directly update the

predefined subtemplate, including renaming it.

- When you work on your copy of the subtemplate, add your own content or edit what's already there, but don't

remove anything.

- The exact steps can vary depending on your version of Microsoft Word.

Modify Shared Components in the Subtemplate

Here's how you edit a copy of the predefined subtemplate that has the shared components:

PUN

L

RS

Click Navigator > Tools > Reports and Analytics.

Click the Browse Catalog icon.

In the catalog (the Folders pane), expand Shared Folders > Common Content > Templates.
For Workflow Notification Subtemplate, click More and select Customize.

If you're not using the Customize option, even though it's recommended:

a. Click Copy in the toolbar with Workflow Notification Subtemplate selected.
b. Inthe catalog, expand Shared Folders > Custom > Common Content > Templates. Create a Templates
folder in this location if it doesn't exist.
c. Click Paste in the toolbar.
In the catalog, with the Templates folder open under the Custom folder, click More for the subtemplate and
select Rename to give it a new name.
Click the Edit link for the renamed subtemplate.
In the Templates section, click the link in the Locale column.
Save the subtemplate .rtf file to your computer.
Open the .rtf file with Microsoft Word.

o To add alogo, insert your own image in the subtemplate.

o To change button or link text, edit the text accordingly. Make the same edits wherever that button or link
text appears in the subtemplate.
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CAUTION: To make sure that your layout templates reflect these changes without more rework, don't
edit any other text in the subtemplate .rtf file.

10. Update Word options so that existing links remain intact in the subtemplate.

a. Click File > Options > Advanced.
b. Inthe Word Options dialog box, click Web Options in the General section.
c. Inthe Web Options dialog box, open the Files tab.
d. Deselect the Update links on save check box.
11. Save your changes in Word.

Upload the Modified Subtemplate

Now you upload your subtemplate to the Bl catalog:

In the catalog, expand Shared Folders > Custom > Common Content > Templates.

Click Edit for your subtemplate.

In the Templates section, click the Upload icon.

Select your modified .rtf subtemplate and a locale, and click OK to replace the original subtemplate.

PUWUNa

Point Layout Templates to Your Subtemplate
Update all the report layout templates that you want to apply your subtemplate to:

1. In Microsoft Word, open the .rtf file for the layout template, as you would to make any other changes to the
notification.

2. At the beginning of the document, change the subtemplate reference. For example, change <>
import:xdoxsl:///Common Content/Templates/Workflow Notification Subtemplate.xsb?>tO <?import:xdoxsl:///
Custom/Common Content/Templates/My Workflow Notification Subtemplate.xsb?>.

3. Save your work.

4. Test things out to make sure you see your subtemplate changes in the notification output.

Related Topics
- Whatis a subtemplate?

« Customize Pixel-Perfect Reports

Use Quick Parts for Workflow Notifications

Use the Quick Parts feature in Microsoft Word to insert reusable pieces of formatted content. When you edit copies of
predefined report layout templates for workflow notifications in Word, you can add predefined Quick Parts content to
your .rtf file.

Quick Parts are helpful when you do more advanced work on layout templates. For example, from the Quick Parts
gallery, you can select and add a table in a format that's consistent with predefined tables already on your notifications.
The predefined Quick Parts content is available in a style template .dotx file on My Oracle Support.

I Note: The exact steps can vary depending on your version of Microsoft Word.
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Prerequisites
To get the predefined Quick Parts content into your Quick Parts gallery:

1. Open Quick Parts for Configurable Workflow Notifications (2215570.1) on My Oracle Support at https://
support.oracle.com.

2. Download the .dotx file and save it to your Microsoft Word template folder, for example C:\Users\<user name>
\AppData\Roaming\Microsoft\Templates. You need to save the .dotx file where the Normal.dotm Microsoft
Word template is stored.

Also, to preview your layout template changes before uploading the .rtf file back to the Bl catalog:

- Generate sample report data from the data model for the report that you're editing.
Download a local copy of the subtemplate that applies to the layout template.

Adding Quick Parts Content to Workflow Notifications

To insert content from the Quick Parts gallery into a layout template:

1. Inthe Bl catalog, find the predefined report with the layout template that you want to modify.
For the report, click More and select Customize.

If you're not using the Customize option:

a. Copy the predefined report and paste it in an appropriate subfolder within the Custom folder.
b. Click the Edit link for the copied report.
3. Click Edit for the layout template to insert Quick Parts content into, and save the .rtf file to your computer with
a new file name.
Open the .rtf file with Microsoft Word.
Put your cursor where you want to insert new content.
From the Insert tab on the ribbon, click Quick Parts within the Text group, and select the component to insert.
Edit the inserted component as needed and add any other components.
Save your changes in Word.

0ONo U b

Previewing the Layout Template Changes

To preview your edits before uploading your layout template to the Bl catalog:

1. On the ribbon, open the Analytics Publisher tab and click Sample XML within the Load Data group to import
sample data from the data model. Skip this step if you already loaded sample data.

2. At the beginning of the document, replace the path with the location of the downloaded subtemplate file on
your computer. For example, change <?import:xdoxsl:///Common Content/Templates/Workflow Notification
Subtemplate.xsb?>tO <?import:file:///C: /Template Directory/FinFunWorkflowNotificationSub.rtf?>.

3. From the Analytics Publisher tab on the ribbon, click HTML in the Preview group.

4. If the preview reflects your changes as expected, then change the path back to the original location.

5. Save your changes in Word.

Uploading the Modified Layout Template

To upload your layout template to the Bl catalog after previewing the changes:

1. Backin the catalog, click Edit for the report within the Custom folder, if that page isn't still open.
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Click the View a list link.

Click the Create icon on the table toolbar.

In the Upload or Generate Layout section, click Upload.

Upload your edited .rtf file with a unique layout name.

Back on the page for editing the report, click Delete for the layout template that you downloaded earlier.

Click the Save Report icon.

NO VA WN

Related Topics
 Quick Parts for Configurable Workflow Notifications

« Understand Style Templates
- Test Data Models and Generate Sample Data
« Customize Pixel-Perfect Reports

Set Up Content to Appear in Only Email or In-App
Workflow Notifications

The same .rtf report layout template is used for both email and in-app notifications. When you edit a copy of
predefined templates, you can make content conditional. For example, add an attribute and have it appear only in email
notifications.

The logo, action buttons, and links at the end of email notifications are predefined to appear only in emails, based on
the subtemplate. The approval history is usually predefined to also appear in the body of only email notifications. Any
conditional setting you apply to these components in the .rtf template won't override the predefined setup.

Prerequisites

Generate sample report data from the data model used for the report, and save the .xml file to your computer.

Defining Conditional Regions

To define a conditional region of content that appears only in email or in-app notifications:

Open your .rtf report layout template in Microsoft Word.
On the ribbon, open the Analytics Publisher tab and click Sample XML within the Load Data group.
Select the .xml file you downloaded to import sample data from the data model.
In your .rtf document, select the content you want to make conditional.
On the ribbon, click Conditional Region within the Insert group.
In the Conditional Region dialog box, on the Properties tab, select sinpisonrInenoTIF from the Data field list in
the General section. The values in this list come from the sample data you imported from the data model.
Select Date/Text from the next list.
In the Condition 1section, select Equal to from the Data field list.

9. Inthe corresponding text field, enter true for content to appear only in in-app notifications, or false for content

to appear only in emails.

10. Make sure that form fields containing the conditional logic are inserted around your selected content. The
beginning form field, ¢, should be immediately before the conditional content, and the closing form field, &c,
should be immediately after. Move the form fields as needed.

cCUupPUWNDS
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Tip: To make sure you're looking at the correct form fields, double-click the ¢ form field to open the
Conditional Region dialog box and see the BinDIsONLINENOTIF Setting.

11. Save your changes in Word.

Entering Conditional Code

If the data model for your report doesn't have the sinpisonLineNoTIF attribute, then:

1. Inyour .rtf report layout template, put your cursor immediately before the content you want to make
conditional.

2. Enter the following code, which functions the same as the c form field:
o <?if:BINDISONLINENOTIF='true'?> forin-app only
o <?if:BINDISONLINENOTIF='false'?> for email only

Put your cursor immediately after your conditional content.

Enter <?end if?>, which functions the same as the ec form field.

Save your changes in Word.

AW

Related Topics
- Best Practices for Content and Layout in Workflow Notifications

» Add a Branding Logo and Change Other Shared Components in Workflow Notifications
- Test Data Models and Generate Sample Data

Preview Changes and Upload Layout Templates for
Workflow Notifications

Before uploading .rtf files for report layout templates to the Bl catalog, preview the output with your changes in
Microsoft Word. You can avoid uploading a broken report that displays an error in the notifications sent to users.

I Note: The exact steps can vary depending on your version of Microsoft Word.

Before You Start

- Generate sample report data from the data model used for the report, and save the .xml file to your computer.

Download a local copy of the subtemplate that applies to your own report layout template:

a. In the Bl catalog, expand Shared Folders > Custom > Common Content > Templates if you're using
a modified subtemplate, or Shared Folders > Common Content > Templates for the predefined
subtemplate.

b. Click Edit for Workflow Notification Subtemplate.

In the Templates section, click the link in the Locale column.

d. Save the subtemplate .rtf file to your computer.

o
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Preview Output

To generate sample output from a local layout template:

1. Open your .rtf report layout template in Microsoft Word and make your edits.

2. Ontheribbon, open the Analytics Publisher tab and click Sample XML within the Load Data group.

3. Select the .xml file you downloaded to import sample data from the data model.

4. At the beginning of your .rtf document, replace the path with the location of the downloaded subtemplate file
on your computer. For example, change <?import:xdoxsl:///Common Content/Templates/Workflow Notification
Subtemplate.xsb?>tO <?import:file:///C: /Template Directory/FinFunWorkflowNotificationSub.rtf?>.

5. From the Analytics Publisher tab on the ribbon, click HTML in the Preview group.

6. If the preview reflects your changes as expected, then change the path back to the original location.

7. From the Analytics Publisher tab on the ribbon, click Validate Template in the Tools group.

8. Alsoin the Tools group, click Check Accessibility.

9. Save your changes in Word.

Upload the Modified Layout Template

Here's how you upload your layout template to the Bl catalog after previewing the changes:

1. Back in the catalog, click Edit for the report within the Custom folder, if that page isn't still open.
2. (Click the View a list link.
3. Click the Create icon on the table toolbar.
4. Inthe Upload or Generate Layout section, click Upload.
5. Upload your edited .rtf file with a unique layout name.
6. Back on the page for editing the report, go back to the list view.
7. Select the Default Layout check box for your layout template. If you ever want to go back to the predefined
layout, you can select it as default later.
8. C(lick the Save Report icon.
Related Topics

 Best Practices for Content and Layout in Workflow Notifications
- Test Data Models and Generate Sample Data

Reports and Data Models Used for Procurement
Notifications Based on Reports

You can configure Oracle Analytics Publisher reports to send email and in-application notifications for some Oracle
Fusion Cloud Procurement workflow tasks. Each business process area uses different Oracle Analytics Publisher reports
and data models for configuring the email or in-application notifications.

Reports and Associated Data Models

This table shows the Oracle Analytics Publisher reports and associated data models that are available for configuring
both email and in-application notifications for procurement business processes. The navigation to the business process
folders is: Oracle Analytics Publisher > Catalog > Shared Folders > Procurement folder. Under this folder you can find
the following business process folders having configurable notification reports and data models.
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Business Process

Purchasing

Self Service Procurement

Sourcing

Sourcing

Sourcing

Sourcing

Sourcing

Sourcing

Sourcing

Sourcing

Suppliers

Suppliers

Suppliers

Suppliers

Report

Purchase Order Notification Report

Requisition Approval Email Report

Negotiation Invitation Email Report

Seller Negotiation Award Decision Notification
Report

Seller Negotiation Bid Disqualification
Notification Report

Seller Negotiation Change Schedule
Notification Report

Seller Negotiation Invitation Notification Report

Negotiation Award Decision Notification Report

Award Approval Notification Report

Negotiation Approval Notification Report

External Supplier Registration Approved FYI
Email Report

External Supplier Registration Rejected FYI
Email Report

External Supplier Registration Request To
Resubmit Email Report

External Supplier Registration Save for Later
Email Report

Chapter 7
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Data Model

Purchase Order Notification Data Model

Requisition Approval Email Data Model

Sourcing Notifications Data Model

Seller Negotiation Award Decision Notification
Data Model

Seller Negotiation Bid Disqualification Data
Model

Seller Negotiation Change Schedule Data Model

Seller Negotiation Invitation Data Model

Negotiation Award Decision Notification Data
Model

Award Approval Notification Data Model

Negotiation Approval Notification Data Model

External Supplier Registration Approved Email
Data Model

External Supplier Registration Rejected Email
Data Model

External Supplier Registration Email Data Model

External Supplier Registration Email Data Model

For each of these listed business process areas, you can use the associated reports and data models to configure both

email and in-application notifications.
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Configure Purchase Order Email Approval Notifications
Using Reports

This example shows how to configure workflow email notifications for the purchase order approval business process
using an Oracle Analytics Publisher report.

You use Microsoft Word to edit the RTF template used for notifications. You can modify the Oracle Analytics Publisher
template only if you have the Bl Administrator role.

In this scenario, you want purchase order approvers to see the notes to suppliers.

The following table summarizes key decisions for this scenario.

Decisions to Consider This Example

Which report, data model and layout For updates to email notifications for purchase order approval:
template do | update?
«  Purchase Order Notification Report

- Purchase Order Notification Data Model

- Purchase Order Approval Layout

Do | want to add prompts and headers to No, not for this example.
the layout template?

Do | want to add data model attributes to Yes, the Note to Supplier attribute.
the layout template?

Which language do | use for the RTF English (United States).
template?

Summary of the Tasks

Configure a purchase order email approval notification to add an attribute by:

Adding an attribute to the data model.

Exporting the data model XML file.

Downloading the report layout template.

Adding data model attributes to the template.

Uploading the modified report layout to the Oracle Analytics Publisher catalog.

A WNRA

Prerequisites

1. Download and install the Oracle Bl Publisher Desktop: http://www.oracle.com/technetwork/middleware/bi-
publisher/downloads/index.html.

2. Download and install the Template Builder for Word to use Microsoft Word to edit the layout templates. To
download, install, and set up Template Builder for Word, see Creating RTF Templates by Using Bl Publisher

97
ORACLE



Oracle Fusion Cloud Procurement Chapter 7

Creating and Administering Analytics and Reports for Workflow Notifications
Procurement
Mg Template Builder for Word: http://www.oracle.com/webfolder/technetwork/tutorials/obe/fmw/bi/bip/
tb4word/tbwordbip.htm.

3. To preview the configured templates, download a local copy of the subtemplate that applies to your own report
layout template:

o Signin to the Oracle Analytics Publisher server with the Bl Administrator Role to open the Oracle
Business Intelligence Home page.

o Click Catalog.

o Inthe Bl catalog, go to Shared Folders > Common Content > Templates for the predefined
subtemplate.

o Click More for the Workflow Notification Subtemplate.
o Click the Download option.

o Save the subtemplate file to your computer.

Add an Attribute to the Data Model

In this task, you add the Note to Supplier attribute to the data model.

1. Signin to the Oracle Analytics Publisher server with the Bl Administrator Role to open the Oracle Business
Intelligence Home page.

2. Click Catalog.

3. Onthe Catalog page, in the Folders section, expand Shared Folders > Procurement > Purchasing and select
Data Models to display the data models in the right pane.

4. Under Purchase Order Notification Data Model, click More, and then click Copy.

5. Inthe Folders section, expand Shared Folders Custom Procurement Purchasing.

6. Click the Paste Resource icon.

7. Under Purchase Order Notification Data Model click Edit.

8. On the PurchasingNotificationDM page, in the Data Model section, select PurchaseOrderDraftLineDataSet.

9. On the Diagram tab, click the Edit Selected Data Set icon.

10. On the Edit Data Set dialog, under SQL Query, after the line for the Category ID, add a line and enter:

Line.NOTE_TO_VENDOR AS NoteToSupplier.

11. Click OK.

Export the Data Model XML File

In this task, you export the XML file that includes the data model attributes predefined for the notifications. Perform
this task to enable previewing your modified template. This task is also required to add data model attributes to the
template.

1. Sign in to the Oracle Analytics Publisher server with the Bl Administrator Role to open the Oracle Business
Intelligence Home page.

2. Click Catalog.

3. On the Catalog page, in the Folders section, expand Shared Folders > Custom > Procurement > Purchasing to
display the data models in the right pane.
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4. Under Purchase Order Notification Data Model, click Edit to open the Diagram tab on the
PurchasingNotificationDM page.

Note: To ensure that all data sets include requested elements with undefined values in the output XML data,
do the following:

o Inthe Data Model section, select Properties.
o Inthe Properties section, select Include Empty Tags for Null Elements.

o Inthe Data Model section, select Data Sets.

Note: To add data model attributes to the template, perform steps 5 and 6. Otherwise, skip to step 7.

5. Click the Data tab.

6. Enter values for the following key attributes for an existing purchase order. Key attributes enable you to pull in
all the purchase order attributes:

o Document Number
o Sold-to Legal Entity
o Change Order Number

7. Click View to see the sample data in the report, and all the available attributes. Verify the Note to Supplier

attribute is in the list.
8. Click Export.
9. Inthe Opening PurchasingNotificationDM dialog box, select Save File and click OK.
10. Save the PurchasingNotificationDM_.xml file to a local drive.

Download the Report Layout Template

In this task, you create a copy of the report layout template in the Custom folder, and download a copy of the template
to your local drive to modify it.

1. Signin to the Oracle Analytics Publisher server with the Bl Administrator role to open the Oracle Business
Intelligence Home page.

2. Click Catalog.

3. Onthe Catalog page, in the Folders section, expand Shared Folders > Procurement > Purchasing to display
the templates in the right pane.

4. Under Purchase Order Notification Report, click More, and then select Customize. A copy of the Purchase
Order Notification Report is created automatically in the Custom folder.

On the Catalog page, in the Folders section, expand Shared Folders > Custom > Procurement > Purchasing.
Under Purchase Order Notification Report, click Edit.

On the Purchase Order Notification Report page, next to Data Model, click the Select Data Model icon.

On the Select Data Model dialog, expand Custom > Procurement > Purchasing.

Select the Purchase Order Notification Data Model, and click Open.

10. Under Purchase Order Approval Notification Layout, click Edit.

11. On the Opening PurchaseOrderApprovalNotificationLayout.rtf dialog box, select Save
File and click OK to save the document to your local drive. Save the template with the name
UpdatedPurchaseOrderApprovalNotificationLayout.rtf to distinguish it from the original template.

S B
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Add Data Model Attributes to the Template

To modify the purchase order approval email notification, you edit a local copy of the RTF report layout template in
Microsoft Word. In this task, you add the Note to Supplier data model attribute to the report template.

| Note: The exact steps can vary depending on your version of Microsoft Word.

P ow

Rl B

10.
1.
12
13.
14.

15.

On your local drive, open the UpdatedPurchaseOrderNotification.rtf template in Microsoft Word, with the
Template Builder installed.

Select the Bl Publisher tab.
In the Load Data section, click Sample XML.

In the dialog box to select XML data that appears, browse to open the PurchasingNotificationDM_.xml file you
saved in the Exporting the Data Model XML File task. Then click Open.

In the Data loaded successfully dialog box, click OK.

Scroll to the TSRHLines section of the notification.

Place the cursor after the C UnitPriceEC line and press the Enter key.

On the new line, enter Note to Supplier:, and place the cursor at the end of the text you entered.
On the BI Publisher tab, in the Insert section, click the 123 Field button.

On the Field dialog box, locate and select the NoteToSupplier attribute.

Click Insert.

Click Close to return to the UpdatedPurchaseOrderNaotification.rtf template.

Save and close the document.

Before uploading the RTF files to the business intelligence (BI) catalog, you should preview the output with the
changes you made. You can avoid uploading a broken report that displays an error in the emails sent to users.

Proceed to the task Uploading the Modified Report Layout to the Oracle Bl Publisher Catalog.

Upload the Modified Report Layout to the Oracle Bl Publisher Catalog

You must perform this task to use the modified report layout for notifications.

1.

v A WN

o

10.
1n.
12.
13.
14.

Sign in to the Oracle Analytics Publisher server with the Bl Administrator Role to open the Oracle Business
Intelligence Home page.

Click Catalog
On the Catalog page, in the Folders section, expand Shared Folders > Custom > Procurement > Purchasing.
Under the Purchase Order Notification Report, click Edit.

On the Purchase Order Notification Report page, on the right side of the page, click Add New Layout to open
the page with the Create Layout and Upload or Generate Layout sections.

In the Upload or Generate Layout section, click the Upload icon.

In the Upload Template File dialog box, in the Layout Name field, enter Updated Purchase Order
Notification Report.

In the Template File field, browse for the modified UpdatedPurchaseOrderNotificationLayout.rtf template
on your local drive, select the template, and click Open.

In the Upload Template File dialog box, from the Type list, select RTF Template.

From the Locale list, select English (United States).

Click Upload to open the Processing dialog box and return to the Purchase Order Notification Report page.
On the right side of the page, click View a list to open the Layout page.

In the row for the Updated Purchase Order Notification Report, select the Default Layout check box.

On the right side of the page, click the Save Report icon.
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Related Topics
- Best Practices for Content and Layout in Workflow Notifications

» Preview Changes and Upload Layout Templates for Workflow Notifications
« How You Modify Copies of Predefined Reports

Configure Oracle Sourcing Notifications Using Reports

This example shows how to configure workflow email notifications for the Oracle Sourcing business process using
Oracle Analytics Publisher reports. You use Microsoft Word to edit the .rtf template used for notifications.

The following table summarizes key decisions for this scenario.

Decisions to Consider This Example

Which template do | update? Negotiation Invitation Email Report

Do | want to add prompts and headersto ~ Yes
the layout template?

Do | want to add data model attributesto =~ BUYERCOMPANY
the layout template?

Which language do | use for the RTF English
template?

Summary of the Tasks

Configure the Negotiation Invitation Email Report by:

Add an Attribute to the Data Model.

Export the data model XML file.

Download the report layout template.

Edit email body information in the template.

Add data model attributes to the template.

Upload the modified report layout to the Oracle Analytics Publisher catalog.

cCUupAUWNRA

Prerequisites

1. Download and install the Oracle Analytics Publisher Desktop: http://www.oracle.com/technetwork/
middleware/bi-publisher/downloads/index.html.

The Template Builder for Microsoft is included in the Oracle Analytics Publisher.
2. To preview the configured templates, download a local copy of the subtemplate that applies to your own report
layout template:
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a. In Oracle Analytics Publisher, click Catalog.

b. Inthe Oracle Analytics Publisher catalog, go to Shared Folders > Common Content > Templates for the
predefined subtemplate.

Click More for the Workflow Notification Subtemplate and then click Copy.

In the Folders section, expand Shared Folders > Custom > Procurement > Sourcing.
Click the Paste Resource icon.

Click More for the Workflow Notification Subtemplate and then click Download.

Save the subtemplate to the local drive on your computer.

@ -0 2n

Add an Attribute to the Data Model

In this task, you add attributes to a data model.

OV hWNA

7.

Sign in to the Oracle Analytics Publisher server to open the Oracle Analytics Publisher Home page.
Click Catalog.

On the Catalog page, in the Folders section, expand Shared Folders > Procurement > Sourcing.
For Negotiation Invitation Email Report, click More, and then click Customize.

In the Negotiation Invitation Email Report, click the Sourcing Notifications Data Model.

On the Diagram tab, select the header to which you want to add an attribute and then click the Edit Selected
Data Set icon.

Add the required attribute and click OK.

Export the Data Model XML File

In this task, you export the XML file that includes the data model attributes predefined for the notifications. Perform
this task to enable previewing your modified template. This task is also required to add data model attributes to the

template.
1. Signin to the Oracle Analytics Publisher server to open the Oracle Analytics Publisher Home page.
2. C(lick Catalog.
3. Onthe Catalog page, in the Folders section, expand Shared Folders > Custom > Procurement > Sourcing.
4. For Negotiation Invitation Email Report, click Edit.
5. In the Negotiation Invitation Email Report, click the Sourcing Notifications Data Model to open the Diagram
tab.
Note: To ensure that all data sets include requested elements with null values in the output XML data, do the
following:
o Inthe Data Model section, select Properties.
o Inthe Properties section, select Include Empty Tags for Null Elements.
o Inthe Data Model section, select Data Sets.
6. Click the Data tab.
7. Click View to see the sample data in the report, and all the available attributes.
8. Click Export and select Save File and then click OK.
9. Save the SourcingNotificationsDM_.xml file to a local drive.
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Download the Report Layout Template

In this task, from the Custom folder you download a copy of the template to your local drive to modify it.

1. Sign in to the Oracle Analytics Publisher server to open the Oracle Analytics Publisher Home page.

Click Catalog.

On the Catalog page, in the Folders section, expand Shared Folders > Custom > Procurement > Sourcing.
Select Negotiation Invitation Email Report, click Edit.

For Negotiation Invitation Email Body Layout, click Edit.

In the NegotiationInvitationEMailBodyReport.rtf dialog box, select Save File and then click OK to save the
file with the name UpdatedNegotiationinvitationEMailBodyLayout.rtf to distinguish it from the original
template.

cuhuwN

Edit Email Body Information in the Template

To modify email content, you edit a local copy of the .rtf report layout templates in Microsoft Word.

I Note: The exact steps can vary depending on your version of Microsoft Word.

1. Open the UpdatedNegotiationInvitationEMailBodyLayout.rtf template in Microsoft Word with the Template
Builder installed, if not already open.

Scroll to the buyer name.

Place your curser at the end of the BUYER_NAME and press enter.

Enter the attribute BUYERCOMPANY.

Save the document.

vihWN

Add Data Model Attributes to the Template

In this task, you add to the report template attributes that exist in the predefined data model.

I Note: The exact steps can vary depending on your version of Microsoft Word.

1. Open the UpdatedNegotiationinvitationEMailBodyLayout.rtf template in Microsoft Word with the Template
Builder installed, if not already open.

2. Select the Oracle Analytics Publisher Publisher tab.

In the Load Data section, click Sample XML.

In the dialog box to select XML data that appears, browse to open the SourcingNotificationsDm_.xml file you
saved in the Exporting the Data Model XML File task. Then click Open.

In the Data loaded successfully dialog box, click OK.

Add the required data model attributes.

Save and close the document.

Proceed to the task Uploading the Modified Report Layout to the Oracle Analytics Publisher Catalog.

P w

O Now

Upload the Modified Report Layout to the Oracle Analytics Publisher
Catalog

You must perform this task to use the modified report layout for notifications.

1. Signin to the Oracle Analytics Publisher server to open the Oracle Analytics Publisher Home page.
2. C(lick Catalog.
3. On the Catalog page, in the Folders section, expand Shared Folders > Custom > Procurement > Sourcing.
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4.

For the Negotiation Invitation Email Report, click Edit.

5. For Negotiation Invitation Email Body Layout, click Properties.
6. For Templates, click the Upload icon.
7. Inthe Template File field, browse for the modified UpdatedNegotiationlnvitationEMailBodyLayout.rtf
template on your local drive, select the template, and click Open.
8. In the Upload Template File dialog box, from the Template Type list, select RTF Template.
9. From the Locale list, select English.
10. Click OK to open the Processing dialog box and return to the Negotiation Invitation Email Report Data Model
page.
11. Click Save.
12. On the right side of the page, click View a list to open the Layout page.
13. In the row for the UpdatedNegotiationlnvitationEmailReport Template, select the Default Layout check box.
14. On the right side of the page, click the Save Report icon.
Related Topics

 Best Practices for Content and Layout in Workflow Notifications

+ Preview Changes and Upload Layout Templates for Workflow Notifications

- How You Modify Copies of Predefined Reports
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